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Introduction 

Trns•port and the Trns•port Suite of Software 

Trns•port is the American Association of State Highway and Transportation Officials 
(AASHTO) information system for managing transportation programs.  Info Tech, Inc., 
developed Trns•port in 1982 to help state highway agencies and attorneys general with highway 
construction bid collusion and anti-trust investigative efforts.  Since then, InfoTech has added 
significant additional capabilities to provide operational and management information support 
for State Departments of Transportation and other construction contract activities.  Activities 
include management-level decision support; project cost estimate and proposal preparation, bid 
letting and award management, and construction contract management.  In October 1985, 
AASHTO purchased Trns•port for licensing to all member agencies to share in the continued 
development and use of Trns•port software. 

There are presently nine Trns•port software modules.  Florida DOT is using six of these 
modules.  Their relationships to each other are shown in Figure 1 on the next page.  The ones in 
use by the Department are: 

Trns•port BAMS/DSS (Decision Support System) provides a complete historical database of 
construction contract information, a set of analysis models, and the capability for ad hoc query 
and analysis.  Using the SAS system’s integrated graphics and statistical presentation capability, 
the BAMS/DSS module provides a fully integrated management decision support system for 
highway agencies.  The Trns•port BAMS/DSS applications include executive information 
requests, summary reports for management, bid management and monitoring analyses, market 
analyses and cost indices, project planning, project cost estimation, and legislative presentation. 

Trns•port CES (Cost Estimation System) provides Department estimators the means by which 
to produce various types of Job estimates such as parametric, cost-based, and bid-based 
estimates.  Predefined and ad hoc formulas can be incorporated in the estimating process, and 
users can assign funding and program information to CES Jobs.  The Trns•port CES module can 
work in combination with the BAMS/DSS module to produce accurate, historically based 
estimates.  It can also work in conjunction with the PES module, sending and receiving project 
and proposal data that aids in the production of Job estimates.   

Trns•port PES (Proposal and Estimates System) provides Department design, contract 
administration, and estimating staff with a computerized tool to help with project definitions, 
funding specifications, project cost estimation, contract proposal creation, and bid letting 
packaging.  The detail cost estimate for the Plans, Specifications and Estimate package (P S & E) 
package and bidding proposal are two key outputs of the PES module.  Integrating the PES and 
BAMS/DSS modules provides automated estimation capabilities with sophisticated statistical 
analyses of historical bid information. 



Trns•port LAS (Letting and Award System) provides bid letting personnel with automated tools 
to manage the plan and proposal holders lists, bid data entry, bid tabulation and low-bid analysis, 
and contract award processing.  Besides processing the letting activity, one of the key functions 
performed by the LAS module is vendor file management, including vendor qualification, 
affiliation, and Disadvantaged Business Enterprise/Women’s Business Enterprise (DBE/WBE) 
information. 

Trns•port Expedite (Electronic Bidding System) is designed to work with the PES and LAS 
modules to streamline the bidding process.  The Department uses information form PES to create 
and distribute electronic proposal or amendment files to prospective bidders.  The bidders then 
input and submit their item bids in a secure, machine-readable format.  The Department checks 
the electronic bids for validity and data errors and then produces a file suitable for loading into 
LAS. 

Bid Express is used in conjunction with Trns•port Expedite.  Expedite software is used in bid 
preparation.  Expedite is used to electronically prepare and check bids; then submit them over the 
Internet using Expedite to connect to Bid Express.  Bid Express is a storage site that holds the 
bids until the bid date, when it is transferred to the Department.  

Trns•port SiteManager is a comprehensive construction management system that encompasses 
the complete construction management process, from contract award through finalization.  
SiteManager accommodates all levels of construction personnel supporting activities such as 
construction administration, field record keeping, contract record maintenance, contractor 
payment processing, materials management, and civil rights monitoring. 
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Entity Relationships 

Trns•port software can be tailored to the Department’s needs.  To efficiently install and support 
the software in varied environments, Trns•port has modular design concepts and programming 
tools that operate with the least amount of modification. 

Trns•port manages data through a series of header records that link to one another.  There are 
three controlling entities in the PES and LAS modules of Trns•port.  These are headers called 
Project, Proposal, and Letting.  Figure 2 illustrates that a Letting Header may have one or more 
Proposal Headers attached to it, and a Proposal Header may have one or more Project Headers, 
as well as addenda, attached.  The figure also shows that within a project, categories are the first 
order detail to a project, and Items are subordinate to categories.  Keep these relationships in 
mind when using PES. 

Letting-01 

Proposal-A Proposal-B, etc. 

Project 01 Project 02, etc. 

Addendum 001, etc. 

Category A Category B, etc. 

Pay Items Pay Items 

Figure 2 
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Common Windows Terms and Navigation Methods 

Project List Window 

Menu Bar 
Tool Bar 

Click X to close 
the Window 

Menu from Right 
Click 

Minimize and 
Maximize Window 

Selected Record 
using Left Click 

Menu Bar – the Menu Bar contains a list of options.  For example, click on File and the list of 
options include Save, Save As, Print, Open, Close, etc. 

Tool Bar - the Tool Bar contains buttons that invoke tools that are specific to the window that is 
currently active.   

This button will produce the Project List Window. 

This button will produce the Proposal List Window. 

This button will produce the Lettings List Window. 

This button will produce the Vendor List Window. 

Select (from a menu, tool bar, or list window), means to move the cursor to the option to be 
highlighted and click the left mouse button once.  If the option has an arrow to the right of it, 
another selection menu will automatically appear.  Click the choice. 

In this manual, notations such as File > Reference Tables > Item List indicate the order of 
selections from the Menu Bar or the Right Mouse Button Menu. 

Click Refers to clicking once with the left mouse button.   

Rclick    (right click) - Refers to clicking once with the right mouse button.  The action will open 
a menu. 
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DblClick (double click) - Refers to clicking twice in quick succession with the left mouse 
button. 

Close (the X in the upper right hand corner of a window) – To close a window, click the X that is 
in the upper right hand corner of the window.  If you have been editing what is in the window, 
you will usually be prompted to either save or close without saving.  Choose appropriately.  If 
you choose not to save, all of the changes will be lost. 

Minimize (the minus sign in the upper right hand corner of the window) – When this button is 
clicked, the window will be minimized and deactivated.  It will appear at the bottom of the 
screen.  Re-activate the window by clicking on the minimized icon on the bottom of the screen. 

Maximize (the button with a square in it on the upper right hand corner of the window) - This 
button also minimizes and maximizes, but it does not de-activate the window, it merely changes 
the size of the window.   

Check Box – A box that represents a Boolean value (on or off, yes or no).  If an X or a check is 
in the box, then the value is On or Yes.  If there is nothing in the box then the value is Off, or 
No. 

List Box – A drop down box that presents the valid values for a field.  The choices presented 
usually are from a code table stored within the system.  Click an arrow to view the list of 
choices, and choose a value from the list. 

 

Common Trns•port Terms and Definitions 

Batch - A term that refers to a process being submitted and executed in the background without 
intervention by the user.  Reports are an example of processes that execute in batch mode.  This 
also means that a process goes into a queue along with other processes and therefore may have to 
wait its turn to run so the results may not be immediately available. 

Bid-based prices - Estimated prices that are derived from historical data that is stored in 
Trns•port DSS.  These prices are generated for a project or proposal by running a process called 
Generate Bid-Based Prices. 

Bidder - A vendor who bids on a proposal 

Category – A grouping of items on a project.  For maintenance projects, these would be the task 
activity numbers.   

Contractor - Any entity that does business with the Department.  This is synonymous with the 
term vendor. 

Control Group – The assigning of control groups controls who can see which projects and 
proposals in PES and LAS.  There are three places a control group can be assigned.  These are 
users, projects, and proposals.  Please see the Security Administrators Guide for complete 
details and Appendix B to this manual. 

Drill-Down Menus - This term refers to menus that appear when a right click is done on a 
selected record.  As the term implies, every time a right click and select is done, a lower level 
menu or screen appears. 
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Estimate - A cost estimate for a project.  PES can produce three different ones.  They are the 
Preliminary Detailed Estimate, the Proposal Estimate, and the Final Detailed Estimate.   

Filter - A function provided in Trns•port   to help limit the list of records appearing on the 
screen. 

Generic Fields - In Trns•port   this refers to fields that are not used within the core Trns•port   
software for any processing, but which are available for the user to enter data into and then use in 
reporting.  Should the user wish to customize the Trns•port software, these fields would be 
available to them. 

Item - The smallest unit of work on a project.  It is the same as the Department’s term Pay Item. 

Item List (item Reference Table) – This is synonymous with the Department's Master Pay item 
List or File and contains all of the items that are open for use in each item year. 

PES Worksheet – This is a screen provided in spreadsheet format that allows for the entry and 
maintenance of items for a project.   

Planholder – This is a vendor who has received a proposal package.  The planholder can be 
valid for bidding or not. 

Procedurally Required Fields – These fields are deemed very important by the Department and 
therefore should be entered even though the system will not force them to be entered.  An 
example of this is the Control Group field (this field controls who is allowed to view the record 
in question). 

Project - This is synonymous with the Department’s financial project. 

Proposal - A grouping of one or more projects that is advertised for contract. 

Site – A proposal site is an entity which can represent different locations or portions of a project 
to which time can be assigned.  There must be a site 00 record for each project.  This will contain 
the time allowed for the entire project. 

System Required Fields – These are fields that are required by the Trns•port software.  They 
must always be entered. 

Tabbed Folders -This term refers to a screen where many associated records that belong to a 
key record are presented in a folder like form.  A tabbed folder screen looks much like a filing 
cabinet with different file folders in it.  Each tab presents multiple records in a spreadsheet form.  
Many of the same types of records may be edited at the same time.  All associated records are 
saved when the tabbed folder screen is closed.  For example, the tabbed folder for a project has a 
tab for general project information, a tab for categories belonging to that project, a tab for 
funding for the project, etc. 

See Appendix A for a more complete glossary of terms used in Trns•port.   



Getting Started 

Logon to Citrix Metaframe 

Trns•port is supported through the Citrix Secure Gateway.  The applications execute on a Citrix 
Metaframe server.   

Access to the Citrix Metaframe server is via the Internet when away from the Department, or the 
Intranet when accessing it from within the Department.  Either way, access will then be through 
the Citrix MetaFrame XP Website. 

Prior to attempting a log in, the Application Security Coordinator will have assigned a UserID 
and password for access to the proper Citrix Metaframe Group. 

 

From your browser, enter: 
 
https://fdotnfuse.dot.state.fl.us/Citrix/MetaframeXP/default/login.asp?ClientDetection=On. 

 

The Citrix Login screen will 
open.   
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For quick access to Citrix, 
create a shortcut for the 
desktop.  From the Login 
screen,  

• Rclick to see the Mouse 
Button Menu. 

• Click Create Shortcut 
as seen below. 

 

 

 

 

This message box 
will appear.   

 

 

 

• Click OK, and this icon 
will be on the desktop. 



 
 

At the Login screen,  

• Enter the UserID,  

• Password, and 

• Domain as seen in Figure GS.7.   

 

Remember that passwords expire every 65 days. 

 

The first time you log in, and as Citrix software is upgraded, you will receive a prompt to install 
Citrix software.  Respond yes and follow the installation prompts. 

 

Logon to Trns•port 

At the Citrix Application Portal, 
see the Trns•port Applications 
available.   

The screen at right shows the 
applications available to a 
typical user.   

To gain access to other 
Trns•port applications, see the 
Application Security 
Coordinator 

 

 

Set up Citrix Printers 

• Click the Printer 
Configuration Icon to 
set up the regular 
printers to work with 
Citrix Metaframe.   

 

 

• Click each printer 
needed, so that the s
shows as "conne

tatus 
cted".   
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Logon to PES 

The Security Coordinator will have established the system access and security authority.  From 
time to time, for training or other testing events, you may be granted access to the test 
environment.  At those times, the Trns•port Coordinator or the Office of Information Systems 
(OIS) staff will control the security and access.  In general, you will only have access to the 
production environment.   

 

• Click the PES Icon to open PES. 

The screen at left will 
appear.   

• Enter the User 
ID. 

• Tab to and 
enter the 
Password. 

• Click OK, as 
seen at right. 

 

A blank Trns•port PES screen 
will appear.  From this screen, 
access the Proposals List 
window, from which all 
proposal management activities 
will be transacted.   

To access the Project List 
window, press the Project 
button. 
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Field Help 

As you enter data, and have questions about a particular field, the field help may be very useful.  
To access the field help in Trns•port PES,  

• Rclick in the field of 
interest to see the M
Button Menu. 

ouse 

ield 

• Click Field Help. 

Or 
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• Press the H key on the 
keyboard to display f
information. 

 

 

 

 

 

An information screen similar to the one 
seen here will appear. 

 

 

 

 

Changing passwords 

When accessing PES the first 
time, change the temporary 
password assigned by the 
Security Coordinator.   

To change the password, 

• Click Utilities > 
Change Password from 
the Menu Bar 

The Change Password window 
will appear.   

• Enter the User Id. 



• Enter the current password in the Old Password field.   

• Tab to the New Password field and type a new password.   
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It must be at least 6 characters and no more than 13.  
Use a mixture of letters and numbers.   

• Tab to the Re-enter Password field and 
retype the new password. 

• Click OK to save this password.   

Change passwords in accordance with Department 
policy. 

 

Data Security 

To protect the integrity of Trns•port data, take general precautions to safeguard data both from 
unauthorized access, as well as accidental loss. 

PES does not have a time-out feature, whereby the software and hence access to the data are 
automatically locked.  When leaving the PC for an extended period do a normal close of all open 
windows and close PES.  In this way, unauthorized access is not possible. 

Data protection during a power outage is also a concern.  When using tabbed folder windows in 
PES, there is a risk of having a project or proposal become “locked” if there is a power loss.  In 
this situation, the database retains information to the effect that you had a project open, and will 
continue to deny access to users who may need to make changes to the project or proposal.  To 
safe guard against this, avoid keeping multiple tabbed folders open for extended periods. 

A Windows General Protection Fault (GPF) error will result in the same effect on folders as a 
power loss.  Any opened tabbed folders will remain locked until those folders are reopened on 
the same PC that was involved in the GPF incident or the power loss. 

 

Security 

In PES, each UserID is assigned one or more roles that have a set of functions (called security 
tokens) assigned to them.  These roles are assigned users by District or Central Office Security 
Administrators and control what the user may do in the system.  In addition, each user is 
assigned a control group that controls which projects and proposals the user is allowed to see.  
Each project and proposal in the system is also assigned a control group so the user will be 
presented only with projects or proposal that “match” his personal control group.  A project can 
be “passed” from one user to another by changing the control group.  Please see the Security 
Administrators Guide for complete details. 
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Example Control Groups 

Type of User   Control Group   

 
District Estimator  ?D03*   ? is a positional wildcard. 
Production Designer  CD03R312  * is a wildcard for all remaining positions. 
Maintenance Designer MD03 Y302    
Consultant   CD??T123 
District Contracts Office ?L03*    
 
Project   Control Group   Users who can see Project 
A   CD03    District Estimator 
B   CD03Z123   District Estimator, Consultant 
C   CD03R312   District Estimator, Prod Designer 
D   CL03    District Contracts 
E   MD03    District Estimator, Maintenance Proj Mgr 
F   ML03    District Contracts 
G   MD03Y302   District Estimator, Maintenance Designer 
 

Confidentiality 

In PES, the estimated price for an item appears on the same screens as the item number and its 
quantity.  This results in some conflicts over the issue of confidentiality.  Whoever can see the 
project can also see the estimate.  There is currently no way to separate the estimated prices from 
the items and quantities.  If the prices need to be kept confidential, then the control group that is 
assigned to that proposal and project must remain in the Estimators control group.  If the 
estimated prices are not confidential at the time, the control group can be set to the Designers 
control group. 

The proposal and project can be passed back and forth as necessary until the prices do become 
confidential. 

Once the proposal has been advertised the Control Group on the project MUST be left as the 
Contract Administrators control group unless an addendum needs to be processed.  Otherwise, an 
Estimator could change the proposal and project detail and the change would not be reflected in 
LAS.  Any changes that need to be made after advertisement must be made through the 
Addendum process. 

It will be up to each District Office to establish procedures with regard to who has what control 
groups and when the projects and proposals need to be passed back and forth. 

 

Code and Reference Tables 

Code tables and reference tables exist to provide valid values for information stored about 
projects and proposals.  A code table generally consists of only two elements, a code value, and a 
code description.  Reference tables include more information than just the code value and the 
description.  When a code table supports a field on a record, a list box will appear on the screen 



that allows the user to choose from the list of valid values.  List boxes may be accessed by 
Clicking on the down arrow like this one,         or like this one.       

To see the code tables and 
reference tables in Trns•port, 
from the Menu Bar  
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• Click File > Reference 
Tables as seen at right. 

The next window shows a choice 
of Code Table Lists and several 
reference tables. 

The Trns•port Coordinator or 
OIS will maintain code and 
reference tables, except for the 
Item List.  Changes to the 
Trns•port code tables must be 
submitted and approved through 
the appropriate Issues Task Group.  Users can view all of the Code Tables and the item List.   

To see the Item List reference 
table in Trns•port, from the 
Menu Bar 

• Click File > Reference 
Tables > Item List. 

The selection Item List is an 
example of a reference table.  
This table is synonymous with 
the Master Pay Item List.  It 
contains all of the valid items 
for each item year (Pay Item 
Year).   

Authorized persons in the 
Central Estimates Office and 

Central Maintenance Office maintain this Item List table.   

 



The Item List Reference T

To view

able 
 details of a particular 

DblClick the Item. 

Eac t hort 

n all 

 

An item can be marked as 

 that 

n 

e 
 

d. 

Check Box contains the default value that the item will have in th

 Class Function field contains a code that categorizes the item into various groupings 

he Trns•port Filter 

ser with a means to limit the list of records appearing in a window.  The 
st.  

 

item,  

• 

h i em has a long and a s
description.  The long 
description can be up to 60 
characters and will appear o
reports unless the reports are 
otherwise modified.  The short 
description is a maximum of 40
characters and will appear on 
any screen that shows item 
description. 

obsolete by checking the 
Obsolete Item box.  Note
there is a field called "Item 
Obsolete as of", but it is not 
actively linked to project 
records.  If an item has bee
added to a project prior to 
becoming obsolete and the 
project is still active and 
requires a change, when th
Obsolete Item Flag is set, the
item will kick out as an error 
when project changes are save

The Combine with Like Items 
is field when it is added to a 

project. 

The Item
such as utilities, landscape, etc.  This field is very useful in narrowing down the list of items to 
be viewed by use of a filter.   

 

T

A filter provides the u
Filter Function is available on most PES screens.  It is especially helpful in limiting the item Li
Use the filter to enter selection criteria on one or more fields applicable to the active window.  
For example, you may only want to see items in a particular Pay Item Year, or you may want to
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see Projects with a certain Control Group.  The fields that are available to include in the selection 
criteria will depend on the active window. 

PES and LAS are set up to support both upper and lower case characters.  Fields that are 
populated from the Department mainframe will be in uppercase because the mainframe stores 
everything in uppercase.  For instance, the Item Description is in uppercase, so when filtering on 
the Short Description field, look for all uppercase characters.  All code values are stored in 
uppercase.  When filtering on a code-based field, search for uppercase letters.  Other fields, such 
as the second line of the Location field on the Project Header record, can have both upper and 
lower case letters in them.  Be aware of the case of a field when performing a filter. 

To set up a filter from the Tool Bar,  
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• Click the Filter button. 

The list box labeled Column will list 
all of the fields that are available for 
the search.  The Operator list box 
contains the relationships that are available between the field that chosen in the Column list box 
and the entry in the Value box.  The Value contains a literal that is being compared to the field in 
the Column box.  In the example above, a simple filter on the field Item Number is looking for 
items that contain the string 0430.   

For more complex filters, such as ones on multiple fields,  

• Click the Advanced button. 

The Advanced Filter feature allows filtering on more than one field and allows you to save the 
filter so that it can be used repeatedly. 

The Name field contains the name of the filter and allows you to choose from a list of previously 
saved filters. 

The Column, Operator, and Value fields operate the same as they did in the simple filter.  The (+,  
)-,  and And/Or columns allow parenthesis to create complex logic.   

To add the first row: 

• Choose values for the Column, Operator, and Value fields at the top of the screen. 

• Click the Accept button.   

To add another row,  

• Click the Add Row button,  

• Click the row just added.   

• Enter values in the Column, Operator, and Values fields. 

• Click the Accept button. 



In this example the filter is designed to 
show drainage items (Item Class 06) 
that will become obsolete after 
December 01, 2003.   

• Add parenthesis as needed and 
choose either And or Or as 
appropriate.   

To save the filter,  

• Enter a name in the Name 
field. 

• Click the Save button.  

The filter will be available for 
future use.   

To apply the filter now,  

• Click the Apply button. 

 

Code Tables 

The Category Class Work field 
is an example of a field that is 
supported by a code table. 

To view the Category Work 
Class code table, from the M
Bar 

enu 

• Click File > Reference 
Tables > Code Table 
List. 

The Code Table List window 
showing all code tables for 
PES/LAS will open. 

To see the codes for a particular 
code table,  

• Click the table of 
interest then with the 
cursor on the blue band,  

• Rclick to see the Mouse 
Button Menu.  

• Click Code Table Entries.   
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This will show a list of all of the 
entries for that code table.  The 
Office of Information Systems 
(OIS) or the Trns•port 
Coordinator will maintain 
reference tables and code tables.   

Note that structure 
classifications are listed for this 
particular table.  All structure 
categories (Category 01??) 
should be identified by the 
appropriate code in the 
Category Work Class field of 
the Category tab of the project. 

 

PES Components 

Project Header Proposal Header 

Counties 

Long 
Description Categories Special 

Provisions 

Funds Sites 
Addenda 

Items 

Figure 3 

In PES there are two main components - Projects and Proposals.  These two objects are referred 
to as “root level” objects.  They can exist by themselves.  All other data in PES, except for code 
and reference tables, belongs to either a project or a proposal.  Figure 3 shows some of these 
relationships. 

All work in PES begins with the creation of a project.  As illustrated in Figure 2 on page 6, a 
project is composed of a Project Header record; one or more Category records and each category 
can have one or more items belonging to it.  Figure 4 on the next two pages shows a typical 
project development life cycle in PES. 

There are several ways for a project to be created in PES: 



• A project can be loaded from the FM (Financial Management) system.   

• A project header can be entered by hand.   

• A project header can be created by copying from another project.   

• A project header can be created by importing it from a source outside of PES.   

Currently the Department does not have a procedure or standards in place for the loading of 
projects from outside sources. 

 Figure 4 

 

Load historical unit prices and/ or 
update estimated unit prices by hand

Generate Project Line Numbers 

Run a Preliminary Detail Estimate 

Run PES Clist to refresh the Project Header Data (if a Copy 
Special was Performed), Enter additional Project Header detail 

Create/Update Category Records. 

Add Items to the appropriate Category, update item 
fields, and delete Items as needed.

Run the PES Clist or Perform a Copy Special to 
Establish the Project Header 

Update Control Group on Project Header 
to transfer control of project to Estimates
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Create 
Addenda as 
needed 

Generate Bid-based Prices for Proposal and/or 
Update estimated prices based on roll-up quantities 

When satisfied with estimated quantities, generate final 
Proposal Schedule without Proposal Estimate and pass to 
Contract Administration 

Generate a Preliminary Detail 
Estimate for the Proposal

Generate Proposal Section 
and Line Numbers 

Attach Projects to the Proposal 
(string projects)

Generate Proposal Schedule Report; 
Including Proposal Estimate 

Create Proposal Record 

Change Control Group on Proposal to 
enable Contract Administration to access. 
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Maintaining Records in PES 

There are two methods of maintaining records in Trns•port.  These are the tabbed folder method, 
and the drill-down method.  The long-term plan of AASHTO is that the drill-down method will 
be phased out. 

 

The Tabbed Folder Method 

A tabbed folder presents many 
associated records broken out 
and grouped under various 
Tabs.  Each tab represents a 
different type of record, but all 
of the records in the Folder 
relate to each other.  For 
example in the Project Tabbed 
Folder, see the category records 
that belong to that particular 
project grouped under the 
Categories Tab.  All of the item 
records that belong to those 
Categories are found under the 
Worksheet tab, etc.  Using the 
Tabbed folder allows you to view and modify many records at once. 

 

The Drill-Down Method 

The second method of 
maintaining records in PES is 
the Drill-Down method.  This 
method involves selecting one 
record at a time and then 
Rclicking on that record to 
“drill down” to the next level.  
For example, to get to a 
particular item on a Project 
using the Drill-Down method, 
first  

• Highlight the Project, 

• Rclick to see the Mouse 
Button Menu.  

• Click Category List,  
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• Highlight a category. 

• Rclick to see the Mouse 
Button Menu.  

• Click Item List  

 

 

 

 

 

 

 

• Highlight the Item of 
interest. 

• Rclick to see the Mouse 
Button Menu.  

• Click the Item desired. 

 

 

 

 

 

• Click the Change 
Button to make changes 

• Click the Close Button 
when complete. 
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Creating Projects 

Adding projects into Trns•port PES should be thought of as involving two steps.  The first is to 
create a project header, and the second is to add the project detail. 

In general, projects can be brought into Trns•port PES in one of the following ways: 

• Create a project header through an interface program. 

• Enter a project manually through the either the Add or Tabbed Folder Add window 
from the right mouse button. 

• Enter a project manually through either the Edit > Add or Edit > Tabbed Folder Add 
window from the Menu Bar. 

• Copy detail from one project to another. 

To create a new project, use the FM Interface to create the project header and then add project 
details into the new project, or enter a few fields of data to create a project header and then 
complete information from the FM Interface. 

 

Project List window 

To view the list of projects, 
from the Menu Bar  

• Click File > Open 
Project List 

Remember that one of the fields 
on the project header is the 
Control Group.  FM populates 
this field.  If you download a 
project that is not a part of the 
control group, you will not be 
able to see it on the project list. 
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Another method of invoking the Project 
List window is to 

• Click the Project button on the 
Tool Bar.   

When the mouse is over a button on the 
Tool Bar, an information box will 
appear that will identify the button by 
name. 

 

 

 

These methods also apply to viewing other List Windows in Trns•port.  There are four main List 
Windows in Trns•port that the Department uses.  These are  

• Projects,  

• Proposals,  

• Lettings,  

• Vendors.   

The Department is not using the Prime Project function. 

 

The FM Interface 

The FM Interface was created to both create and refresh financial and Work Program 
information in Trns•port PES.  The refresh feature of the interface runs every night and updates 
fields in all projects in PES possessing valid FinProj Numbers. 
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To execute the FM Interface on 
the mainframe, 

• Enter TSO,  

• Get to a READY 
prompt  

• Type TSM and 

• Press <Enter>. 

 

 

 



 

 

 

 

At the Trns•port Interface 
screen,  

• Enter B to either add a 
project, or refresh a 
project, 

• Press <Enter>. 

 

At the Add/Refresh Transport 
Projects screen, enter as many 
financial projects as needed.   

• Enter one FinProj 
number per line.   

• For the first line, enter A
(for SEL).  

 

• Enter 01 (for CARD 
ID). 

• Enter all 11 digits of the 
FinProj Number.   

• Press <Enter>.   

To add another project,  

• Enter A (for SEL). 

• Enter 02 (for CARD ID) 

• Enter all 11 digits of the FinProj Number.   

• Press <Enter>.   

If you make an error in the length, an error message will be displayed.  However, there is no 
validation of the accuracy or existence of the FinProj number in the FM system as data is 
entered. 

When you have completed entering projects,  

• Press <Enter> again without entering any data on the row.  
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At the Job Card Information 
Screen, you will be prompted to 
enter a printer ID, a name, and 
phone number.  When that is 
complete,  

• Type SUB on the 
command line and  

• Press <Enter>. 
A batch job is submitted that 
will load the selected projects 
into PES.  The job name and 
number appear on the screen to 
the left. 

 

Check on the progress of the job 
in IOF.  The job output will be 
put into the IOF queue. 

 

In IOF, view the output of the 
job to see if it processed 
successfully.  Determine the 
sequential number of the job.  
Then enter that number on the 
command line.  This shows a 
list of output sections.   

 

 

Look for the one that is labeled 
REPORT and select it by 
putting an S next to it, or by 
entering the sequential number 
of the REPORT output.  You 
may have to press the F8 key to 
page down to see the REPORT 
output. 



If nothing appears in the 
REPORT output, look at the 
output labeled ERRORRPT.  
For example if the FinProj 
entered does not belong to your 
district, this message in the 
output labeled ERRORRPT. 

At the Disposition of Log Data 
Set screen  

• Choose a process 
• Press <Enter>. 
• To exit press F3 

 

To exit the FM Interface  

• Type an X at the 
command prompt 

• Press <Enter>. 

 

A TSO screen will reappear 
with a ready prompt.   

• To exit, type logoff 
• Press <Enter>. 

 

 

When the FM Interface completes, the projects will appear in the Projects List window.  (If your 
Projects List window is open, you will have to refresh it by closing it and reopening it before 
your new project(s) will appear.)  These new projects will contain an Access Control Group that 
is accessible to your district.   

 

Creating a Project from Scratch 

If you are creating a “real” project from scratch, use a proper FinProj number.  Leave the FM 
supplied fields blank and then run the FM Interface to refresh these fields later.  Enter the 
procedurally required fields for the Project Header. 
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To add a project header 
manually,  

• Rclick to see the Mouse 
Button Menu from 
anywhere in the Project 
List window. 

• Click Tabbed Folder 
Add. 

Or,  

• From the Menu Bar, 
Click Edit > Tabbed 
Folder Add.   

 

This will display an empty 
Project Tabbed Folder.  Enter 
the Project Header information 
first and then proceed to the 
other tabs.   

Most fields are blank, but some 
are defaulted to particular 
values, such as the Unit System 
field (default is English).  Most 
field defaults may be changed 
as appropriate.   

Proceed to enter data in page 1 
of the general tab for the 
following fields: 

Project Number     Enter the Financial Project (FINPROJ) Number. 

Pay Item Year     A default value of 00 has been set.   

Fed/State Project No.     A default of N/A is assigned.  For Federal Aid projects enter the 
appropriate number. 

Description     Enter the project description.  It will be updated from the FM system. 

Unit System     The default value is “E” for English.  Change it if necessary. 

Const. Eng.  Pct      The default value is 0.00.  Do not change it. 

District     Enter the managing district for the project, by clicking on the list box and 
selecting the district. 

Project Work Type     Select from the List box. 



Project Type     Select from the List box. 

Control Group     Assign a control group to the project that matches the personal control 
group, except that no wild cards (“*” or “?”) may be used in the Project Control Group.  
See Appendix A for a discussion of the Control Group structure.   

Other fields may be left at their default values.   

• Save the project by clicking the Save Icon. 

**** IMPORTANT ****When adding a project from scratch remember to enter the 
control group, otherwise the project will become “lost” 

 

Creating a Project Using Copy Special 

Copy Special is a function that provides a quick way of creating Projects or Categories.  It takes 
an existing Project or Category and creates a new Project or Category by copying ALL of the 
records associated with the existing Project or Category.  The new Project or Category can then 
be edited to make the appropriate changes. 

This method will not only create the Project Header, but will also copy all of the other records 
associated with the source project.  All of the records in the Tabbed Folder of the original project 
will be copied to the new project. 

To initiate a Copy Special for a 
project,  
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• Click the source project 
from the Project List 
window. 

• Click Edit > Copy 
Special from the Menu 
Bar. 

 

This will open a window that 
asks what project to create u
the copy.  The project you are 
copying to cannot already exis

 

sing 

t. 

o perform the copy, 

Project Control Number  

The new Project Control Number should be a va
created is a template or temporary project. 

T

• Enter the new 

• Click OK.  The new project will be 
created. 

lid FinProj Number, unless the project being 



Project Data 
Updating Project Headers 
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To update an existing Project 

 
Mouse Button 

• 
. 

 

 

he General tab 

he General tab contains two pag

highlighted are the ones that are populated from FM.   

 Project No. 

i 

These f t l 
Group) should NEVER be 

 

ult 
 Pay Item Year will 

plete information in any 
ct the FM 

 

Header record,  

• Rclick on the project to
open the 
Menu.  

Click Tabbed Folder 
Change

 

T

T es of Project Header information.   

The fields that are 

Project Number   Pay Item Year  Fed/State

Description   Location  Unit System 

Road Number   Status   Road Section Number 

Beginning Termin  District  Ending Termini 

Control Group 

ields (except for Con ro

updated directly in Trns•port 
because the nightly FM refresh 
process will over write them.  
These fields can be refreshed on
demand by running the FM 
Interface. 

The Pay Item Year will defa
to 00.  The
not be reset when the refresh 
runs. 

If there is incorrect or 
incom
of the FM fields, conta
Administrator to have the fields
updated in FM.   



To view page 2 of the Project 
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Header information,  

• Click the page 2-radio 

 ed Amt of 
 field 

 will 

 

e

The n page 2 come from FM.   

If a code table supports the field, 

ow that appears. 

A li o

 the list box by clicking on it. 

If yo ty
incorrec
the orig sc> 

e field.  

t 

 of

button. 

Estimat
Project    This required
is filled when you run the 
process Generate 
Preliminary Detailed 
Estimate.  This process
be run several times over the 
project development life.  It 
must be run after the final
Engineers Estimate for 
historical purposes.  When th
as the Engineers Estimate. 

 Type of Road and Work Mix fields o

 contract transfers to SiteManager and DSS this field transfers 

To update fields other than those populated by FM, on any screen 

• Type over the field.   

• Click in the field. 

• Click the down arr

st b x of selections will appear.   

• Choose the desired value from

u pe something 
tly and wish to restore 
inal value, press <E

while you are still in th
This does not work if you 
selected a value for a field by 
choosing it from a list box.  If 
you need to recover the change 
and have gone beyond the 
particular field, close the projec
and NOT SAVE it when the 
prompt comes.  If you do this, 
you lose all changes made in the 
current session. 

This is an example of a list box  valid codes appearing for the field Project Work Type. 



The Counties Tab 

To view the Counties,  

• Click the Counties Tab. 

ates the 
percent
county.   

 

e 

t 
the county information is incorrect 

plete contact the Work Program Administrator and have them correct the county 

 to open the Mouse Button Menu. 

opriate. 

Rem m efreshed from Work Program.  If corrections 
nee o rk Program office. 

 Category is a record that 
t is a way 
ms 

 list 

leven 

 

The county record indic
age of the project in each 

The FM Interface will provide 
the county records and their
percentages.   

If you create a project from 
scratch, add county information 
or leave this tab blank and run 
the FM Interface to refresh th
project. 

If you add a county that does no
however, it will set the Percent of Project Length to zero.  If 
or incom

exist for the project in FM, the refresh process will not delete it, 

information. 

To add or delete a County record,  

• Rclick

• Click Add or Delete as appr

e ber that information in the County tab is r
d t  be made, make them through the Wo

 

The Categories tab 

A
belongs to a Project.  I
of grouping related ite
together.  The tab contains a
of all categories included on the 
project.  This project has e
categories including Category 
0000 for funding. 

A full set of category numbers 
and titles is provided for use in
adding pay item detail with the 
initial run of the FM interface. 

When a project will have more 
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than one bridge, add categories, so that the number of structure

Reference Manual for Production Projects & Proposals PES Release 5.7a                                         Page 36 of 129 

s categories is equal to the 

o add a category record  

re in the top half of the Category tab screen to open 
enu.  

This w  the bottom of the screen.   

If there are not two sections of the screen showing, 

utton Menu.  

You h
ion 

A new 
top half of the screen. 

ory 
e 
 

mber.   

Choose from the following list.  
These categories align with the De

G (Required) 0100 STRUCTURES  

 

 

number of bridges in the project.  The first bridge in a project is assigned to category 0100.  
Additional bridges are assigned to category 0101, 0102, 0103, etc.  It is particularly important 
that the category fields for all structures categories be filled as completely as possible.  The detail 
on the category tabs is the source for creating reports to the Federal Highway Administration. 

 

Adding a Category  
T

• Rclick anywhe
the Mouse Button M

• Click Add.   

ill open an input window at

Or  

• Click Edit > Add from the Menu Bar. 

• Rclick in the screen to see the Mouse B

• Click Show Detail. 

 s ould then see both an 
upper and lower sect
of the screen. 

blank line appears in the 

The Category No. field is the 
unique key to the Categ
record and therefore each valu
must be unique to a particular
project.   

• Enter the Category 
Nu

partment’s standard Design Groups: 

0000 FM PROJECT FUNDIN

0200 ROADWAY     0300 SIGNING 

0400 LIGHTING     0500 SIGNALIZATION

0600 LANDSCAPE/PERIPHERAL  0700 ARCHITECTURE

0800 UTILITIES     0900 MASS TRANSIT 
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Cat

ription     Enter the description from the above list. 

 It will be automatically generated 

.00 will appear. 

y Category, 
gth is 

 

the bridge in feet or meters. 

idge 

    

 

egories Tab page 1 

• Complete the following fields for each category: 

Category Desc

Proposal Section Number     Leave this blank. 
later. 

Federal Construction Class     Choose the Design Group from the drop down 
window.  This value is from the FEDCCLS code table.   

Combine w/Like Categories     The default value for this flag is YES. 

Construction Eng. Pct     Not in use.  A default value of 0

Category Length     Assign the full length of the project in the Roadwa
or divide the length between bridges and roadway, so that the combined len
equal to the overall project length.  Enter miles or kilometers. 

Category work Class     For structures it is very important to fill this field.  Choose 
the drop down menu the appropriate classification for the structure.  This field is 
used to classify work for pre-qualifying bidders.   

Structure Work Type      Similar to the Federal Work Category, except that the 
FEDSUPP Code Table is used.   

Category Width     The width of this portion of the project in feet or meters. 

Bridge ID       The Bridge Number.  

Bridge Length (Ft/M)      The length of the bridge in feet or meters. 

Bridge Width (Ft/M)     The width of 

Bridge Type     A 
value selected from 
the attached 
BRDGTYP code 
table that indicates 
the type of br
(e.g., Overpass, 
Trestle Low, etc.). 

Number of Spans 
The number of 
spans of the 
structure 
represented by a
category.   



Categories Tab page 2 

When information on page 1 is complete,  

• Click on the page 2 radio button to display the remaining fields. 

Certain information contained on the general page has been repeated here (e.g., termini, 
stationing, and section number).  It is not required that all categories reflect the same overall 
information.   

 

Required Fields for Category Page 2 

Beginning and Ending 
Termini – FM supplies 
these.  Verify their 
accuracy. 

Unit Number     Not in use 
at this time.  The default 
value is 000.  Do not 
change this value. 

• Click OK in the gray area 
to accept the row of data.   

To enter another category, 

• Click ADD MORE and 
continue. 

• Click OK when complete.  

• Click CANCEL to return to the Categories List window without saving the new record. 

 

The Combine with Like Category Flag 
(See also Combine with Like Items) 

The Combine with Like Categories field 
and the Combine with Like Items field on 
the Item Record control the presentation o
items for bidding in the proposal.  Wh
both of these fields are marked Yes (or 
checked) then items from categories whic
have the same Federal Construction Class 
and the same Category Alternate Code 
will have their quantities combined and 
only be presented once on the prop
bidding. 

f 
en 

h 

osal for 
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For example, if there are two separate categories each of which contained the tem 2515  1  5 
PIPE HANDRAIL and the Combine Flags were both set to Y, then the quantities for these items 
would be combined and the item would appear only once on the proposal.  If the Combine with 
Like Category Flag is set to N then this will override the settings on the Combine with Like 
Items flags and the items for that category would not be combined on the proposal.  If the 
Combine With Like Category flag is set to Y then individual items can be excluded from 
rolling up by setting their flags to N.   

 

Like Category  Like item Result 

 Y   Y  Quantities Combined 

 N   Y  Quantities Not Combined 

Y   N  Quantities except for particular item combined 

 

Creating a Category Using Copy Special 
There is a Copy Special feature for a category similar to the Copy Special for a project.  The 
difference is that only the particular category and its associated records (Item detail) will be 
copied and not the entire project.  Because of this, the project that you are copying to must 
already exist but the category you are copying to must not exist. 

This function can be used to create the Category records for a new project.  Copy them from a 
template job that has all of the categories in it or copy individual categories from existing jobs 
that are similar to the one being created.  This saves a lot of typing by eliminating the need to 
add items by hand.  Once the Category is copied, add or delete items and update the quantities as 
appropriate. 

To initiate the Copy Special for 
a category, from within the 
Category Tab of the project,  

• Highlight the category 
number to be copied. 

• From the Mouse Button 
Menu, Click Copy 
Special 

Or 
• From the Menu Bar, 

Click Edit > Copy 
Special. 
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A screen will ask for a destination Financial Project Number and a destination Category Number.  
The duplicate category may be created in the Project that is open, or it may be created in another 
Project.   

• Enter a Project Number. 

• Enter a Category Number. 

• Click OK when you are finished. 

 

Alternatively, copy a category 
by drilling down to the source 
project from the Project List 
Window. 

• Rclick the project in the 
Project List window to 
see the Mouse Button 
Menu.  

• Click Category List. 

 

 

Then, 

• Click the Category to 
copy 
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• From the Menu Bar 
Click Edit > Copy 
Special. 

A screen will ask for a 
destination Financial Project 
Number and a destination 
Category Number.  You may 
create the duplicate category in 
the Project that is open, or you 
may create it in another Project.  
While this screen is not 
identical to the one shown 
earlier it displays the same information. 

• Enter a Project Number. 

• Enter a Category Number. 

• Click OK when you are finished. 



The Category 0000 Record 
There is one special category 
record that is created by the FM 
Interface.  This is the Category 
0000 record.  It contains all of 
the funding information for the 
project.  Trns•port permits 
funding for each category; 
however, The Department has 
elected to store the entire 
project funding under the 0000 
Category.  The funding 
information will not be 
updateable in Trns•port and 
Category 0000 should never 
be deleted.   

If any funding information is in error, contact the Work Program staff to have it corrected.  Here 
is an example of the Funding Information that came from FM.  Note that the only category 
number seen is Category 0000.  You will not be allowed to update, add, or delete any funding 
information. 

 

Updating Category Records 
From the Projects List window, 

• Rclick to see the Mouse 
Button Menu.  . 

• Click Tabbed Folder 
Change. 

• Click the Categories 
tab.   

To update a category record, 

• Highlight the Category. 

This will make the category 
detail available at the bottom of 
the screen.   

• Enter the desired information in the fields at the bottom.   

• Click the OK button when complete. 

To update the information on Page 2, click the page 2 Radio button and change the data in a 
similar manner. 
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The scroll bar at the right in the bottom half of the screen allows you to see additional fields for 
that particular category.  The scroll bar on the right hand side of the upper half of the screen 
allows you to scroll up and down through the category records. 

 

Deleting a Category Record 
There are two ways to delete a 
category record. 

To delete a category record 
from the Category Tab in the 
Project Tabbed Folder, 

• Rclick the record. 

• Click the Delete option 
on the Mouse Button 
Menu. 

 

Or  

 

 

• From the Menu Bar 
Click Edit > Delete. 

• Click the record to be 
deleted. 

You will be prompted with a 
window that asks to confirm the 
delete. 

 

 

 

 

To continue with the delete,  
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• Click the Yes button, otherwise 
Click the No button.   

If you press the Yes button you will 
again be prompted with a window telling you how many records will be deleted and what other 
dependant records will be deleted. 



When you delete a category, you will also delete any fund records and any item records that 
belong to that category.  Again, if you do not want to continue with the delete, press the No 
button. 

• Click the Yes to delete the 
category record and all of its 
associated records. 

These same methods of Rclick    to use mouse button menus or selecting the option from the 
Edit selection on the Menu Bar are available for most other entities such as Projects, Proposals, 
Items, etc.  You may also select functions such as Add in the same manner. 

 

Saving Data in Tabbed Folders 

To save the changes in the Tabbed Folders, click the X at 
the upper right hand corner of the Tabbed Folder window.  
You will be notified as to which tabs had changes recorded 
for them and you will be prompted to confirm the save. 

If you choose No then, you will exit the Tabbed Folder 
window without saving anything, but also without 
changing anything. 

If you choose Cancel, no changes will be posted to the database and you will be returned to the 
Tab that was active when you clicked the X. 

Choosing Yes above will give you this window.  
If you click the Yes button, the data will be 
validated and then the changes will be made to the 
database. 

Do NOT click the Save As button.  This option 
creates a temporary file on the PCs hard drive.  It 
also locks the project that you were working on so 
that no other users can access it.  This is very 
dangerous because if the PC has a failure, the project will be unavailable until the Trns•port 
Coordinator or an OIS person can clear the lock on it.  In addition, any changes that were not 
committed to the database will be lost. 

When you make changes to the Worksheet, all of the records will be verified and updated, 
regardless of whether or not the record was actually changed.   

Always click the X to save while in Tabbed Folder Add.  As with most windows programs, the 
Save button on the Tool bar or Click File > Save from the Menu Bar are also available 
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Cautions on Deleting Data 

Trns•port has three levels of delete that are available in some instances they are described here, 
with the caution that users should in general Never use Power or Strong delete unless the full 
effect of the action is understood. 

Delete   The lowest level of deleting.  Usually deletes one data record from one file, and one 
Delete Warning window.   

Power Delete   This second level of deleting, deletes multiple records from more than one file.  
Two Delete Warning windows will appear.  For example, if you are deleting a bid-letting 
package, Power Delete will delete the letting call, bids, planholders, and proposal.   

Strong Delete   The third level of deleting, deletes multiple records from more than one file and 
three Delete Warning windows will appear.  For example, if you are deleting a bid-letting 
package, Strong Delete will delete the letting call, bids, planholders, the proposal and the 
projects, items and funds (the whole tree of data).   

 

The Breakdowns Tab 

A default value of "1" and "Worksheet Breakdown Default" should appear automatically to 
satisfy Trns•port system requirements.   

This tab is used for construction projects to classify them using the "search 16" process and 
contractor qualifications.   

 

The Worksheet Tab 

Adding Items to Project Categories 
The FM system has no Item data.  Most of the work will be in this Worksheet tab entering Items 
and quantities.   

All items must be associated with a category under a project.  An item is put under a particular 
category for several reasons.  First, it fits with that grouping of items.  Assign the items to 
categories as they relate to the MMS activity the category represents. 

There are several ways to add items to a project category.  The first method is using the PES 
Worksheet.  This method is good to use for initially adding many items, however it can be 
overwhelming if you are only updating a few item quantities or adding only a few items.   



To access the Worksheet 

• Rclick the Project to s
the Mouse Button Men

Click T

ee 
u 

• abbed Folder 

• orksheet 

 

dding and Deleting Rows 

 the Worksheet 
se Button 

• 

 

• Click Insert Row, and a 

• End 

 

On a blank screen, the option 

 

Change.   

Click the W
tab.   

 

 

 

A
Add or delete rows in the 
Worksheet by  

• Rclick in
to see the Mou
Menu.  

Click the appropriate 
action.   

 

 

 

blank row will be 
inserted prior to the 
highlighted item.   

Click Add Row to 
and a blank row will be 
inserted at the end of the
Worksheet.   

that will show in the Rclick    
menu will be Add.  The Insert 
Row and Add Row to End will 
not appear on the list until other
rows are there.  Select these 
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options from the Edit option on the Menu Bar. 

To quickly add many rows to the end of the worksheet, hold down the <Shift> key and press the 
<Insert> key repeatedly. 

• Click Delete, and all of the selected (highlighted) rows will be deleted.  There will be a 
delete confirmation screen. 

The data in any grayed out columns cannot be updated.   

To update a field  

• Click the field. 

• Enter the new data.   

The arrow button beneath the Item Number column will open the item List from which to choose 
an item.  Keep in mind that this takes a while to load so it is better to just type the Item Number 
in if you know it.  The item description and some of the other grayed out fields will 
automatically be populated from the item Reference table. 

Any fields that are flags must have a value of either “Y” or “N”.  These values MUST be capital 
letters. 

Even though the Department is not using breakdowns, the Worksheet was designed around 
breakdowns and breakdown items.  Therefore, several fields are required even though they will 
not be used.  Breakdown ID is one of these fields.  The number "1" should always be entered for 
this field.  The Breakdown Item Line No and the Project Item Line No column are also 
required.  These columns each contain sequential numbers.  There are automated methods of 
generating these numbers. 

To generate the sequential 
numbers for the Worksheet 

• Click Edit > Assign 
Line Numbers from the 
Menu Bar.   

• Click Project items or 
Breakdown items as 
appropriate.   

Project item Line numbers will 
be generated in increments of 
five.  Breakdown Line item 
numbers will be generated in 
increments of one. 
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To set the Breakdown Id of all 
records to "1", 

• Enter a "1" in the first 
record and tab out of 
that field. 

• Click on the Column 
Heading to highlight t
Breakdown ID colu

Click Ed

he 
mn. 

• it > Range Fill 
 

This wi  the 
 of 

> Fill Down from the
Menu Bar. 

ll populate all of
records with a Breakdown Id
“1”. 

The Range Fill option will fill all of the records.  Partial range fill is not currently supported.   

Worksheet Field Definitions 
Breakdown ID     Not used, but required by Trns•port.  If the default value of 0001 
does not appear, enter a value of 0001.  Use the Edit > Range Fill option to set all 
occurrences to 0001. 

Breakdown item Comment     Not used. 

Breakdown item Generic Number 1     Not used. 

Breakdown item Generic String 1     Not used. 

Breakdown Item Line Number     This is a required field.  It can be entered 
automatically.  To assign this number Click Edit > Assign Line Numbers > 
Breakdown items from the Menu Bar. 

Breakdown Item Quantity     Enter the quantity for the Item. 

Category Number      Enter the Category Number from the drop down window.   

Extended Amount     The product of the quantity times the price.  Trns•port 
automatically calculates this field. 

Item Alternate    This is a 3-digit code used to identify alternate items.  
Maintenance currently does not use alternate items. 

Item Description     System generated when an Item Number is selected. 
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Item Number     The pay Item Number from the Master Pay item List.  It is 
contained in the ITEMLIST code table of Trns•port. 

Item Units     The unit of measure for the Item, which is system generated. 

Pre-established Price Flag     The Pre-established Price Flag field determines 
whether the Estimated Price of an item will be automatically entered on bidders 
proposal schedules.  If set to “Y” then the item will appear on the bid blanks, 
however the unit price will be filled in and not bid on by the bidder.   

Price Lock Flag     The Price Lock flag field indicates whether manually entered 
estimate price information for any automatic processes will update items.  Enter 
“Y” in this field to restrict modifications to manually entered information, in other 
words, to “lock” the manually entered prices. 

Price Source     The Price Source field identifies the source of the Estimated Unit 
Price.  The entry in the Price Source field must be a value from the PRICSRC code 
table.   

Project Item Generic Code 1     Not in use. 

Project Item Line Number     The Project item Line Number field is a four digit 
number Trns•port uses to identify the item.  Trns•port will automatically enter this 
value it runs a process.  These numbers may be entered directly in the worksheet by 
selecting Edit > Assign Line Numbers > Project items. 

State Mat Flag (Non-Bid item)     The default value for this field is "N".  Non-Bid 
items will not appear in any bid documents, and will not be passed to SiteManager.  
A common use for this field is to identify FHP use on a project. 

Estimated Quantity     Used by Trns•port to determine the extended cost of an item.  
It is generated from the Breakdown item Quantity and cannot be changed. 

Supplemental Description Part One     Not in use. 

Supplemental Description Part Two     Not in use. 

 

The Attachments Tab 
All of the Trns•port tabbed folder windows have an Attachments tab.  It allows you to integrate 
OLE-compatible documents (for example, letters or spreadsheets), web pages, and plug-in 
applications into Trns•port.  At this time there are no standards established for use of this feature.   

 



Customizing the Worksheet 

You may do some things to customize the look of the Worksheet.  Change the size and location 
of a column or hide columns.  See Appendix C for a more complete discussion on customizing 
the worksheet.  With Citrix Metaframe, the customizations discussed here will be saved to the 
Citrix Server in use when the changes were saved.  You will have to re-do these settings for each 
server in use. 

 

Rearranging Columns in the Worksheet 

To rearrange the order of the columns in the Worksheet, put the cursor on the heading of the 
column to move and hold down the left mouse button while you drag the column to its new 
location.  You may only move the column around on the screen that is currently visible, so you 
may have to drag and drop several times. 

 

Resizing Columns  

To resize a column, place the cursor on the right hand vertical gridline of the column heading to 
resize.  The cursor will change from an arrow to a vertical bar with two arrows on each side.  
Hold the left mouse button down, drag and drop the vertical line to where you want it. 

 

Hiding Columns 

Some Worksheet columns such 
as the Generic fields will not be 
used.  These can be hidden so 
the Worksheet is smaller.  This 
also protects from inadvertently 
entering information in the 
fields.  This is important in the 
case of the Supplemental 
Description field, because data 
in this field affects how items 
roll up on the proposal.  The 
Department has made the 
decision NOT to use the 
Supplemental Description 
field. 
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To hide columns,  

• Click Edit > Hide 
Columns from the 
Menu Bar.   

This will open a screen that 
shows all of the columns that 
can appear on the Worksheet.   

• Highlight the columns t
be hidden by clicking on 
them.   

o 

ata, 

t 

ort. 

is,  

 Edit > Generate 

 

 

To re-show a particular column 
click it to un-select it.   

To show all columns again,  

• Click the Show All button. 

 

Sorting Records in the Worksheet 

To sort the records in the Worksheet, click the Sort 
Button           on the Tool Bar.   

• Choose the columns to sort and their order.   

• To add additional fields, Click the Add button.   

• Click the Apply button when complete.   

 

Printing the Worksheet 

To verify what Worksheet d
it is often helpful to have a 
hardcopy report to look at.  Ge
a listing of the Worksheet by 
running a Worksheet Rep

To do th

• Click
Worksheet Report > 
Visible Columns from
the Menu Bar.   
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The Print Worksheet message window will open 
showing the printer to be used.   

If the printer is correct  

• Click OK 

Otherwise 

• Click Printer 

• Select another printer.   

• Click OK 

 

Using the Drill-Down Method  

The Drill-Down method 
involves selecting a particular 
object and then Rclick it to 
Drill-Down to the next level or 
DblClick to update the 
associated information.  This 
method deals with one Item 
record at a time within one 
category at a time within one 
project at a time.   

Reference Manual for Production Projects & Proposals PES Release 5.7a                                         Page 51 of 129 

 

Adding Items  

By using the Drill-Down 
method, you may open a 
window that shows all of the detail of an element in a single display.  For Pay Items, this window 
is very similar to the one seen at the Master Item list.  For Categories, it is similar to the lower 
window portion of the 
Categories Tab with pages one 
and two combined. 

To Drill-Down on a project to 
the category level 

• Rclick the project of 
interest. 

• Click Category List 
from the Mouse Button 
Menu. 

The list of categories will open. 



• Rclick the category to which to add the items. 
• Click Project items 

List. 
From the Item List window,   

• DblClick the item to 
update. 

Or 

• Rclick and Click Item o
Change.   

r 

To add a new item,  

• Rclick 

• Click Add.   

To delete an item  

• Rclick 

• Click Delete. 

 

To enter changes, first click the Change button if you opened the window with a DblClick.  The 
down arrow after the Item Number field will open the Item.  As in the Worksheet, this takes a 
while so if you know the item numbers it is faster to type them in.  Some fields are backed by a 
code table, and when you click the field, or tab to the field, the arrow will appear allowing 
selection from the table.  Click Close to save the changes and exit the screen. 

 

When you Rclick    from the 
Item List and Click Add, you 
will get a mostly empty screen.  
Unlike the Worksheet, this 
screen will not refer to 
Breakdown fields and the Item 
Line Number is automatically 
assigned.  When re-opening the 
Worksheet after adding items 
through the Drill-Down method, 
the breakdown fields will be 
empty.  Remember to fill them 
in the Worksheet.   
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This is an example of an Add 
Item Screen.   
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After entering the Item Number 
and leave that field, the p
will automatically enter the 
description and the default for
the Combine with Like items 
Flag.   

rogram 

 

he information,  

o save the record.   

he ADD MORE button. 

The n methods is that the Worksheet 

pdating item Quantities and Prices using the Quantities and Prices Window 

uantity and 

 

ject 

 

• k the desired 

• tities and 

 

Note that the Project item 
Sequence Number is assigned 
automatically.  In the 
Worksheet, you had to generate 
this number. 

When you are finished entering t

• Click OK t

• To keep adding records click t

 key difference between the Worksheet and the Drill-Dow
processes many records at a time and the Drill-Down method deals with one record at a time.   

 

U

The Quantities and Prices window is a screen that allows updating of only the item Q
the Estimated Price.  You may not add or delete items using this screen.  It is helpful in the case 
where you have copied the items from another project or a template project and you only need to
change the quantities of the items.  This screen is also accessed via the Drill-Down method. 

To access this screen, 

• Rclick the Pro

• Rclick the Category
List 

Rclic
Category 

Click Quan
Prices. 
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• Enter the quantities or 
 

 

se the Sort function here to get 
 

  

ound in the 
 

 they 

y 

ombining Projects 

e project information when different people have developed different 

or 

ombine the work, designate one of the projects as the host project.  This would 
ber. 

• 

•  any last 
 

 

To com jects 

 project in the 

estimated prices for the
items. 

U
the items into the order that is
best for performing the updates. 

Hide columns and move 
columns ar
Worksheet.  However, the
changes are not saved, as
are when customizing the 
Worksheet.  They will only be 
there for the duration of the sta
in that window. 

 

C

You may want to combin
portions of a project that in the whole has extensive category and pay item detail.  You could 
have a situation where three people are developing a project in separate parts, such as lighting, 
signing and marking, or structures, where each one has developed details in these several 
categories. 

• To c
usually be the project having the real FINPROJ Number as its Project Control Num

Verify that all of the category numbers to be involved in the ultimate project pre-exist in 
the host project. 

If you have made
minute changes to the host
project, save it so that the 
project information exists 
in the database as well as in
the memory of the PC.  The 
database is where the 
process of combining the 
projects will occur. 

bine two or more pro
into a single project: 

• Click the host
Projects List window.   
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Trns•po  this project and add categories and pay items from other 

abbed Folder 
ject.   

•  tab to 
orksheet for the 

Note th
items displayed, but in another 

t. 

• Click File > Import > 
Combine Projects from 

 

 

rns•port displays a list of projects.  Use the 
ilter and Sort options to help locate projects 

 

ine. 

lick OK.   

rt will keep the header from
projects to it.   

• Click T
Change to open the pro

Click the Worksheet
open the W
selected project.  

at in this case, there are pay 

situation, there may not be.  A 
view of the category tab of this 
project would reveal that all 
necessary category numbers exis

 

 

 

the Menu Bar. 

 

 

 

 

 

 

T
F
to combine.  Only combine projects that have
the same Pay Item Year and same Unit 
System. 

• Click a Project Number to comb

• C



Trns•port returns you to the 
Worksheet where it loads data 
from the selected new project into 
the host project Worksheet 

• To combine other projects 
with the first project, repeat 
these steps for each one. 

• When all projects have 
been combined, rerun the 
Assign Line Numbers 
process for both Project 
Line Numbers and 
Breakdown Line Numbers. 

 

Generating Reports and Running Processes 

In PES, reports and other batch jobs are run by the Run Process selection.  For more on 
generating reports see Appendix D. 

Project Level Reports  

Using the Mouse Button Menu 
After entering projects, add categories, and items, and designate where the work is being done, 
run project-level reports.  The Preliminary Detail Estimate process produces a printed report that 
details the Items.  Trns•port also summarizes the estimate with subtotals for item categories and 
funds.  

• Click the project for 
which to generate 
reports in the Projects 
List window.   

(To select more than one 
project, hold down the CTRL 
key and select additional 
projects with the mouse). 

• Click Run Process 
from the Mouse Button 
Menu.   

This will display a list of 
processes that are available. 

Reference Manual for Production Projects & Proposals PES Release 5.7a                                         Page 56 of 129 



 

Reference Manual for Production Projects & Proposals PES Release 5.7a                                         Page 57 of 129 

This is a sample list.  The security authority may not 
permit you to run all of the processes available in the 
system.   

 

 

 

Generating a Preliminary Detail Estimate 
One of the most useful reports is the Preliminary Detail Estimate.  It may be run at both project 
and proposal levels.  Its value is that it contains all of the structural detail of the project or 
proposal with line numbers, sections, categories, items, and quantities.  Trns•port also 
summarizes the estimate with subtotals in several formats.   

To run a Preliminary detail Estimate, 

• Click Generate Preliminary Detail Estimate from the Processes List window 

• Click OK.   

Trns•port displays the Detail Cost Estimate Parameters window. 

The parameter selection window has three pages.  
Page 1 shows a default selection to renumber the 
Item line numbers.  To renumber them,  

• Click the box to set the check mar. 

• Click the Page 2 tab. 

 

 

 

 

On page 2, enter the level of summarization.  
Project is the default level.  This option 
determines whether to run the Detail Estimate for 
a project, prime project, or proposal.  The 
Department is not using prime projects.  After 
entering the level of summarization,  

• Click the Page 3 tab. 

 



Page 3 shows the Parameters window, which 
allows you to select the reports to produce.   

• Check the boxes of the reports to generate.   

• Click Submit to run the process. 

• Click Parameters to change process 
submission parameters. 

Or  

• Click Cancel to return to the Projects List 

window without running a process. 

When you click Submit, two informational windows will appear.   

The first will inform you that the process has been submitted.  
When they appear, 

• Click OK.   

When the process is completed, this window will 
appear. 

• Click OK.   

 

Using the Menu Bar 
Select the project or projects for which you will run reports.  To do this, click the project in the 
Project List window.  To select more than one project, use the <Ctrl> key and/or the <Shift> 
key.   

 

Then,  

• Click File > Run 
Process from the Menu 
Bar. 
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The Process List will appear.  The contents of the P
List window will vary depending upon what object yo
are running the process on (project verses proposal, et
   

rocess 
u 
c.).

The List Projects report will generate a report that lists 
project header information for all selected projects. 

 

Proceed as above when using the Mouse Button Menu commands. 

 

Viewing Reports  

To see the results of this 
process, from the Menu bar, 

• Click File > Process 
Status.   

 

 

 

 

 

 

 

This screen lists all of the 
processes recently run. 

• Highlight the report just 
run (check the date and 
time columns),  

• DblClick the blue band. 
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Usually reports are labeled 
OUTPUT.TXT.  Sometimes 
there will be more than one 
report available.  For example, 
you may have an exception 
report in addition to the regular 
report.   

These are the reports available 
from this process. 

• Click the report to be 
opened. 

• DblClick the report 
OUTPUT.TXT and 
review the report on 
screen. 

The Show system files check box will show all of the files the system generates.  If the process 
gets an error when it is run, you may need to look at these files when you work with the System 
Administrator to debug the problem.  Otherwise, leave the box unchecked to limit the list of 
output files displayed. 
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The report window has a t
associated with it that permits 
text editing.  You may highlight
a word or phrase and change the
font, use line out, bold etc. 

Scroll thro

oolbar 

 
 

ugh the report by 
t 

 

The Save As Text and Save As Rich Text buttons allow you to save the report to a file on the 

 button closes this screen and returns to the output list screen. 

eleting Reports  

using the scroll bars at the lef
and at the bottom of the screen.

When you have determined that 
you want a copy of the report, 

• Click the Print button 
at the bottom of the 
screen. 

PC. 

The Done

 

D



Over time, this Process Status 
List window will grow to the 
point that the scroll bar is 
needed to see all of the reports.  
Each user will need to delete 
reports that are no longer 
needed.  To do this, 

• Hold down the CTRL 
key. 

• Click each process to be 
deleted.  In this example 
three records have been 
highlighted. 

After highlighting the rows to 
be deleted,  

• Place the cursor on one 
of the blue bands.   

• Rclick to open the 
Mouse Button Menu 

• Click Delete. 

 

 

 

 

 

 

 

A delete confirmation window will.   

• Click YES TO ALL 
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The Process Status List window 
will appear.  It will be necessary 
to routinely delete unneeded 
process files  

 

 

 

 

 

 

 

Printing Reports 
To print the report,  
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• Click the Print button 

A window will open showing the default printer 
you set up for Citrix.   

• Click Print again and the report will go to 
the designated printer. 

If the report is printing in Portrait, click the 
Printer Setup button, and at the layout tab, change the layout to landscape. 

 

NOTE:  If you have not previously done so, configure Citrix Metaframe to print the reports.  
Follow the procedures in Appendix D. 

 



Creating Proposals 

A Proposal in PES is one or more projects that are going to be let as one entity.  A Proposal 
becomes a Contract once it is awarded.  In a Project, you had Category and Project Line Item 
Numbers.  In a Proposal, you will have Sections and Proposal Line Numbers that serve a similar 
function in managing the proposal.  In a project, the Combine Like Items flag determine which 
items are combined for bidding purposes.  The Combine with Like Categories flag controls how 
categories are presented to the Bidders on the Proposal.  If Categories and items are set to 
combine, then the quantities will be added together and presented only once on the Proposal for 
bidding.  Sections are created from Categories.  The example below illustrates what happens in a 
Proposal when two Projects are “strung” together under the same Proposal. 

 
Project A 

0200 
Roadway 

0101 
Structures 

0200 
Roadway 

0101 
Structures 

Project B 

Proposal 

Section 0001 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this example, the Categories in both Projects are set to combine, with an X in the Combine 
w/Like Categories box.  All of the items in each Category are marked to Combine with Y in the 
Combine flag column on the worksheet.   

In some views, flags may be set with a check mark (√), while in other views they may be set with 
an x.  In either case, these marks are converted to Y when the data is saved and transferred to the 
database.  If a box has a "blank in it, it is transferred to the data base as an N.   

The Proposal automatically rolled up all of the item quantities in the Categories for both Projects 
and put them in Section 0001.  Each item will appear in Section 0001 only once. 

If any category had been marked as Combine = N, then another Section would be created.  If any 
item had been marked as Combine = N, then that item would appear twice (or more) under the 
combined Section 0001. 
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Like a Project, a Proposal has a 
Control Group assigned to it to 
control who can see which 
Proposals.  When you create a 
Proposal, it defaults to your 
personal Control Group.  
Change this immediately if you 
have an "*" or "?" in your 
group.  It must be changed prior 
to adding a project to the 
proposal.  Save the Proposal 
after you fill in the Proposal 
General Tab and then reopen 
the proposal to add the rest of 
the Proposal information and 
attach Projects.   

To access the Proposal List window,  

• Click the Proposal icon. 

To add a new Proposal,  

• Rclick in the Proposal List window and  

• Select Tabbed Folder Add. 

For the Proposal, we will be doing everything with 
the Tabbed Folder functions. 

 

Proposal Data 
The General Tab 

 

General Tab Page 1 
This is the blank Tabbed Folder 
for a new Proposal.  Notice the 
similarity to the Project Tabbed 
Folder; there is a General Tab 
with two pages of information 
and other tabs that contain other 
groups of records that pertain to 
the Proposal.  The Department 
is not using the Special 
Provisions, FY Schedule, or 
Attachments Tabs at this time. 
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Page 1 of the General tab has the following 26 fields: 

Contract ID     A unique identifier for a proposal or contract.  Enter the planned District 
Contract number, and use it as a Proposal Identifier.   

District Let Contracts: Enter the planned District Contract number in the 
general form E#???, where # is District Number and ??? is a sequence number.  
Do not enter dashes or spaces. 

Central Office Let Contracts: Enter the planned "T" number in the general 
form T#???, where # is District Number and ??? is a sequence number.  Do not 
enter dashes or spaces. 

Letting Number     A unique identifying number or alphanumeric for a letting.  It may be 
composed of any combination of eight numbers and letters.  For lettings in the districts, 
allocate two positions for the district number, two for the year, two for the month, and 
two for the date.  This will be in the form of ##YYMMDD, where ## represents the 
district number.  If the occasion should arise that you will hold a second letting on the 
same date, you may insert a "B" in position seven.  The Central Office lettings commence 
with a prefix of CT.  This field will not be filled now. 

Call Number     The order in which bids will be opened for a specified proposal during a 
bid letting.  This field will not be filled now. 

Description     A short description of the proposal. 

Federal/State Project Number     The federal or state project number identifying a 
project, proposal, or contract.   

Contl PCN     This is the lead project to be associated with the proposal.  Enter the 
Financial Project Number of the lead project. 

Location     The site where work is being performed for the proposal. 

Route Number     The route number or road number of the road that is affected by a 
project. 

Pay Item Year     The Item year identifier for Items to be used for the proposed contract. 

Spec Bk Year     The Specification Book to be used in the administration of the contract. 

Road System     A classification of the road.  Select from the drop down menu. 

Proposal Type     A classification for the proposal.  Choose from the drop down list to 
identify a proposal as either to be let in the District or in the Central Office. 

Highway Type     Not in use. 

Bid Method     For Alternative Bidding choose a value from the list box.  Leave the the 
field blank if Alternative Bidding is not involved. 

Highway Number     The identifier for the road being worked on in a project. 



Contract Type     A value, selected from the attached CONTTYP code table.  Note that 
there is a limitation on the use of CC in this field; wherein the Contract ID must begin 
with a T for Central office let contracts. 

Primary District     The managing district. 

Contract Work Type     Choose a code from the drop down window. 

Control Group     On adding a new proposal, the personal Control Group will be entered 
into the Control Group field of the proposal header.  If the personal control group 
contains ? or *, change this control group before saving the proposal header.  Enter a 
Control Group composed only of numbers and letters. 

Set Aside Proposal     Leave this field blank. 

Counties     Enter up to four counties for each proposal (select from the drop down list).  
Trns•port prints this information on some reports, but does not use it in processing. 

DBE/MBE Goal (PCT)     Not in use at this time.  A percentage goal set for 
disadvantaged (DBE) or minority (MBE) business enterprises for a proposal.  The default 
value is 0.00. 

WBE Goal (PCT)     Not in use at this time.  A percentage amount indicating the goal you 
have set for women business enterprises for the proposal.  The default value is 0.00. 

Proposal Class     Select a value from the attached PROPCLS code table. 

Prop DBE Goals     Not in use at this time.  A value, from the attached DBENOTE code 
table that indicates which of the two goals applies to this proposal.  Choose NONE, and 
Trns•port will not print goals on any report.  Choose DBE and Trns•port will only print 
the DBE/MBE goal and will label it a DBE goal.  Choose BOTH, and Trns•port will print 
both the DBE/MBE goal (labeled as an MBE goal) and the WBE goal.  Select from the 
drop down menu. 

Qual.  Classes     Not in use at this time.  A classification of work for which a vendor is 
qualified. 

 

The General Tab Page 2   
Bid Bond     Not used at 

 this time. 

Prev Let As ContID     
Indicates the contract ID 
under which a proposal 
was previously 
advertised. 

Cost of Proposal 
Package     Used for 
planholder invoicing in 
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the LAS module.  This field shows the cost of the proposal package (bid blank, plans and 
specs).  It has a default value of 0.0.  This should be the cost before taxes.   

Section Assignment     Flag telling Trns•port to assign project categories to proposal 
sections automatically or do it manually by entering section numbers in the category 
records.  The default value is Y, which means Trns•port will automatically assign 
categories to sections. 

Cost of Plans     Used for planholder invoicing in the LAS module.  Trns•port will bill 
this cost to purchasers of complete plans for a proposal.  The default value is 0.00.  This 
should be the cost before taxes. 

Special Provisions     This feature is not in use at this time.  It is a flag used to tell 
Trns•port if special provisions will be assigned to this proposal.  The default value is N 
(no special provisions).  Do not change this flag. 

Cost of Specs     Used for planholder invoicing in the LAS module.  Trns•port will bill 
this cost to purchasers of complete plans for a proposal.  The default value is 0.00.  This 
should be the cost before taxes. 

Cost of Proposal    Used for planholder invoicing in the LAS module.  Trns•port will bill 
this cost to purchasers of complete plans for a proposal.  The default value is 0.00.  This 
should be the cost before taxes. 

Min. Order Fee    Used for planholder invoicing in the LAS module.  Trns•port will bill 
this cost to purchasers of complete plans for a proposal.  The default value is 0.00.  This 
should be the cost before taxes. 

Acquis. Time     Used to identify special acquisition times for specialty items required to 
be fabricated under construction contracts. 

OJT Flag     To identify contracts where OJT is required of the contractor.  The Default is 
N for no.   

Special Start Date     Used to identify a delayed start to a contract. 

Proposal Notes     Not i
use. 

n 

or 

If there is only one Project to be 
attached to a Proposal, populate 
some of the basic proposal 
information by filling in the 
Cntl PCN field and importing 
the data for the Controlling 
PCN.  This is also applicable f
the lead project where two or 
more projects are strung 
together.   
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After entering the project 
number in the Cntl PCN field, 
from the Menu Bar, 

• Click Edit> Import 
Controlling PCN Data. 

This will enter information that 
is common from the Project 
Record.  District, Pay Item 
Year, Description, etc.  This 
can save some typing if the 
proposal information will be the 
same as the project information, 
as well as reduce the chance of 
introducing errors. 

A confirmation screen will appear.  To 
continue,  

• Click Yes.   

To stop the process,  

• Click No.   

This box tells what data will be copied from 
the Lead Project Number.  Once the 
information is imported, change it as 
necessary. 

 

The Import Controlling PCN 
function, automatically attaches 
The project to the Proposal and 
it will appear in the Projects 
Tab.   

 

Page 1 will appear like this 
when all of the necessary fields 
have been entered. 

 

 

 

Reference Manual for Production Projects & Proposals PES Release 5.7a                                         Page 68 of 129 



The Description Tab 

After entering the General 
information, move to the 
Description tab. 

 

Enter as detailed a description 
as possible. 

 

 

 

 

 

The Sites Tab 

A Site in PES is a record that has information about the contract time or times within a Proposal.  
A Site record could represent various physical sections of the Project, like Structures for 
example.  Or, a Site can be any other division of a Project. 

 

The Site 00 record.  This 
record will contain the total 
contract time for the Proposal, 
and is required by the system.  
On a new proposal, the tab will 
be empty as seen at the right.  
You must add at least one row 
of data.   
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If the Sites tab looks like this,  

• Rclick in the white 
space. 

• Click Show Detail.   

This will show all the Site 
records in the top half of the 
screen and the detail for the 
selected record in the bottom 
half.  Always show the detail 
before adding a record.   

The screen will now have a 
white area in the center, and a 
lower portion in which detail 
will be entered.   

• Rclick to see the Mouse 
Button Menu. 

• Click Add 

 

The screen is now ready for Site 
data.  Site Number 00 has 
opened as the default.  This is 
the required site to show 
contract time and type of days. 

Required fields for the Site Tab 

Site Numbe

are: 

r   Use the 

se 
.  

Days      Enter 
 

days, 

default value of 00.  

Type of Days     Choo
from the drop down menu
The usual choice will be 
CD from the TIMMETH 
code table. 

Number of 
the number of days planned
for the work.  If Type of 
Days is chosen to be 
Calendar or Working 
then a number of days must 
be entered.  If the type of 
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days is Completion Date, then the Specified Completion Date must be entered and the 
number of days need not be entered. 

Liquidated Damages per Day     there is a default value of $1.00.  Liquidated Damages will 
be handled in SiteManager.  The Site 00 record information passes over to Site Manager as 
the Original Contract Days.  Other Site records pass to Site Manager as Milestones. 

Description      Enter "Contract Time" from the SITEDES code table choices. 

 

Alternative Contracts 
As noted above, the Site Tab information transfers to SiteManager and may be used for a variety 
of ends including Contract Time, Daily Rates, Incentives and Disincentives, and administrative 
information.   

The Site Tab contains a field named Road User Cost Per Day.  This field is to remain blank 
unless the proposal will be processed under Alternative Contract procedures, in which case it 
will be filled as described below.  When Road User Cost Per Day contains a value, the particular 
Site will be used in the analysis of bids to determine the successful bidder.   

For Time Bid contracts there are three items of information to be retained from the 
preconstruction work.  These are: 

 The engineers estimated duration for the Contract Time or Lane Rental period. 

 The maximum number of days that bidders may bid for the Contract Time, or for the 
Lane Rental period. 

 The Road User Cost per Day. 

 

A + B Contracts 
At the General tab, 
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• Select the appropriate 
Type in the Bid Method 
field. 

At the Sites tab enter data in the 
following manner. 

• Site Number   Use the 
default value of 00. 

• Liquidated Damages 
per Day     There is a 
default value of $1.00.  
Do not change this 
value.  Liquidated 
Damages will be managed in SiteManager. 



• Type of Days     Choose CD in the drop down menu from the TIMMETH code table. 

• Number of Days      Enter the Engineers estimated duration for the contract.  

• Road User Cost Per Day     Enter the daily rate determined for the contract. 

• Maximum Days     Enter the maximum number of days that will be indicated in the 
Contract Specifications. 

• Description      Enter "Contract Time" from the SITEDES code table choices. 

• Click OK to save the record to a data row. 

During the analysis phase of the bidding, in conjunction with the bids on Pay Items, the value 
contained in the Road User Cost Per Day times the Number of Days identified for the site will 
be used to determine the successful Bidder. 

 

Lane Rental Contracts 
At the General tab, 

• Select the appropriate 
Type in the Bid Method 
field. 

At the Sites tab create a Site 00 
for the contract time in the u
manner then create additio
Sites as described here.  

• 

sual 
nal 

Rclick in the white 
b 

• 

 

nter information in the 

• e one 

be 

egin 

• d Damages 

ay 

space of the Sites Ta

Click Add to create a 
new record. 

E
following fields: 

Site Number   Us
site for each instance 
where lane rental is to 
managed in 
SiteManager.  B
with 01. 

Liquidate
per Day     Enter the 
value identical to the 
Road User Cost Per D
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to be entered below.  This field will transfer to SiteManager as a Disincentive amount. 

Type of Days     Choos• e CD in the drop down menu from the TIMMETH code table. 

ntal 

•  Days     Enter the number of days that will be indicated in the Contract 

• s" from the SITEDES code table choices. 

tract, 

• ow. 

Du ction with the bids on Pay Items, the value 
l 

onstruction Milestones 
ilestones either with or without Incentives and Disincentives, create a 

 

egin 

• amages 
n 

he 
 

r 

ntive 
i

• p down menu from the TIMMETH code table. 

ne.  
 this 

duration.   

• Number of Days      Enter the Engineers estimated duration for the lane rental time. 

• Road User Cost Per Day     Enter the daily rate determined for the particular Lane Re
activity. 

Maximum
Specifications.  (the Maximum days). 

Description      Enter "Lane Rental Day

• Long Description 1      If there is more than one instance of lane rental on the con
describe the particular location here. 

Click OK to save the record to a data r

ring the analysis phase of the bidding, in conjun
contained in the Road User Cost Per Day times the Number of Days identified for the Site wil
be used to determine the successful Bidder. 

 

C
For general Construction M
Site 00 for the contract time in the usual manner.  Then create additional Sites as described here.  
Enter data on the Site Tab in the following manner. 

• Site Number   Use one 
site for each instance 
where a milestone is to
be managed in 
SiteManager.  B
with Site 20 

Liquidated D
per Day     If there is a
incentive for the 
Milestone, enter t
value.  This field will
transfer to SiteManage
as a Disincentive 
amount.  The Ince
value will be entered in S

Type of Days     Choose CD in the dro

teManager.  Otherwise enter zero. 

• Number of Days      Enter the number of days associated with the particular Milesto
Specified Start Date and Specified Completion Date may be used in conjunction with
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• Road User Cost Per day     Leave this field blank, as the Site is not to be associated with
determining the successful bidder.  

Maximum 

 

• Days    Leave this field blank. 

lar milestone here.  This field may contain up 

 

The Projects Tab 

Attach th
roposal.  Go to the Projects 

e Import 
he 

e 

lick the Project or use 

ey to select 

• 

The Pro he 
top of the screen and are now 
associat sal. 

al 
 

 

ts 
 are 

em Year. 

 Fold
al.  Projects can be attached through the Drill-Down method.  

roposals using the Drill-Down mode of PES. 

• Description      Enter "Construction Milestone" from the SITEDES code table.   

• Long Description 1     Describe the particu
to 60 characters. 

• Click OK to save the record to a data row. 

e Project(s) to the 
P
Tab.  If you used th
Controlling PCN function, t
Cntl PCN will be marked in th
Project List in the lower 
window. 

To assign one or more Projects 
to the Proposal, 

• C
the <Shift> key or the 
<Ctrl> k
multiple Projects.   

Click the single Up-
Arrow button.   

jects will appear at t

ed with the Propo

If you did not select a 
Controlling PCN on the Gener
Tab, place a check mark in the
Controlling PCN box .

Note that all of the projec
displayed in the lower panel
of the same Unit System and 
Pay It

Warning: In the Tabbed
attached to more than one propos
DO NOT attach projects to p

er Change mode, PES has checks to block a project from being 
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Sections Tab 

When entering the Sections tab 
for the first time after attaching 
projects to it, this message box 
will appear.  It is saying that 
Section and Line numbers need 
to be entered for the Proposal. 

This process rolls up like items 
and categories for the proposal. 

 

Close the information window. 

• Click the OK button.   

If the screen has a large area of 
white as seen previously for the 
Sites tab, 

• Rclick to see the Mouse 
Button Menu.  

• Click Show Detail. 

• Click Generate 
Sections & Line 
Numbers button 

If one of the projects or a 
category contains no items, you 
will receive a message like the 
one at the right.   

Exit the Proposal and correct 
the problem in the Project, by either adding items to the Category, or deleting the Category if it is 
not required in the contract.   

• Click OK on the message box,  

• Click the X in the upper right hand corner of the Add Proposal window and save the 
Proposal  

Return to the Proposal List window.   

When adding a proposal or a project the first time using Tabbed folders, do NOT try to save the 
proposal or project by choosing File >Save from the Menu Bar, or by clicking the Save       icon 
on the Tool bar.   
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After the project data has been 

 

r the Categories that made up 

This description will print on 
the P p

s. 

The Genera

When in ess, Trns•
following way:   

• All categories whose FEDCCLS fields are the same will be combined, except when a 
nate.   

• e categories are combined with alternate categories in other projects 
e categories in both projects are identical.   

e section number to each proposal section and updates the 
y category to reflect the section to which it is assigned.   

ggregates items within combined categories (proposal sections) when the 
m Number and Proposal Supplemental Description.  The 

s that are members of an alternate Item set from the section and 
ing the alternate relationship.   

s are 
th projects.   

ot combine, Trns•port will not combine it.   

es.  Trns•port uses the section and line numbers assigned through this batch 
process to generate the proposal items in the Trns•port LAS initialization process.  All proposal-
level reports will use these line number assignments. 

corrected, and section and line 
numbers have been generated, 
the Section Tab will now appear
like this with one or more 
sections.  Review the section 
descriptions, and revise them as 
necessary.  The default titles are 
the description of the lowest 
numbered Maintenance Activity 
fo
that Section.   

ro osal Schedule report 
that is sent to prospective bidder

 

te Section and Line Numbers Process 

itiating the proc port combines the project categories and project items in the 

 
category is an alter

Items from alternat
only when the alternate codes for th

• Trns•port assigns a uniqu
database record for ever

• Trns•port a
items have the same Ite
exception to this is that lump sum items are not automatically flagged to combine. 

• Trns•port removes item
places them in a section describ

• Trns•port combines alternate items across projects only when identical alternate code
used in bo

• If an Item has been marked to n

The process of generating section and line numbers will roll up the project-level items and 
categories to the proposal level and assign proposal line numbers and section numbers to the 
items and categori
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The Proposal Items Tab 

The Items Tab will look like 
this one. 

When a proposal has been se
up, estimators will want to 
review the proposal-level prices 
and quantities.  Estimated prices
may change because of quantity
changes or because the price 
might have changed over time.  
View and modify the es
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t 

 
 

timated 
prices through the Proposal 

he Items tab shows a 

the project level.  This 

oposal level.  
If Item 
previou
Generate Bid-Based Prices 
pro s
weighte
eac r
display
informa
the i
quantit
occurre

Cha e
be chan
pro t
revert t s•port recalculates the extended amount according to the new 
pric

Worksheet. 

 

 

T
worksheet similar to the one at 

worksheet shows quantities 
rolled up to the pr

price estimates were 
sly specified (with the 

ces  or by the estimator), a 
d estimated price for 

h p oposal line Item will be 
ed.  This pricing 
tion is computed from 

est mated price and 
ies of the individual 
nces of the items that were combined into that proposal line Item. 

ng  the estimated price in the Price field as necessary.  However, no other information may 
ged in this worksheet.  If quantities are to be changed, they must be changed in the proper 

jec .  If you change a price inadvertently, press ESC before you leave that field so that it will 
o the original price.  Trn

e you enter.  When you finish making changes, click the window again. 



When you close the window
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, Trns•port displays a dialog box.   

ew 

NO to return to the Proposals List window without changing prices, or  

 to the Proposal Items tab window to make other changes.   

nd the new prices back to the project level.  Each proposal line 
tributed to each of the project Item records that combine into that 

nstances where the sections and line numbers did not roll up items 
alled Generate Section and Line Numbers that can be run for the 

 that will assign the numbers correctly. 

o run the Generate Section and Line No’s process, 
 the Proposal List Window,  

 Mouse Button Menu.   

ion and Line Numbers 
ss window. 

Line Number Assignments box checked. 

 informational 
. 

ctions will have 
bine 

• Click YES to save the n

• Click 

prices,  

• Click CANCEL to return

When you save, Trns•port will se
price estimate will be redis
proposal line Item. 

 

In the past, there have been i
properly.  There is a process c
Proposal List window

T
from

• Rclick to see the

• Click Run Process. 

• Click Generate Sect
(Update) from the Proce

• Click OK. 

• Leave the List Section/

• Click Submit. 

• Acknowledge the two
windows that will follow

After the process is done, the se
been created and the items that are to com
will show up as one line.   

• Return to the Items tab in the Proposal. 

• Click the Generate Section & Line Numbers button at the bottom of the window 

This will load these tabs but will not change the section and line numbers that were generated by 
the process. 

 



Proposal Level Reports 
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Gen a te 

To  
Est

rocess  

 

 

 

• Estimate. 

 

 

 

A w d
the rep

 

 

 

Generating the Proposal Schedule Report  

The Estimator will have the capability of generating the Proposal Schedule Report (bid blanks).  
This should be done to verify that all of the items and sections rolled up as desired and that non-

er ting a Preliminary Detail Estima

run a Preliminary Detailed 
imate at the Proposal Level 

• Rclick to see the Mouse 
Button Menu.   

• Click Run P

 

 

 

 

 

Click Generate Preliminary Detail 

in ow opens to choose which parts of 
ort are needed.   

• Uncheck boxes that are not 
needed. 

• Click Submit. 

 

 



bid and fixed price items wer
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e appropriately marked.  In addition, it is possible that the Estimator 
will want the change the estimated unit price for an item after they see the rolled up quantity. 

 Button Menu.  

• roposal Schedule. 

 

 window opens to choose which parts of 
e report are needed. 

• Uncheck boxes that are not 
needed. 

• Click Submit. 

Cre n

re changes made to the project/proposal scope 
ust be made through an Addendum. 

emember that it is very important to accurately assign Project Line Numbers and Proposal Line 
umbers to each Addendum Item to be added.  You will need copies of the proposal level 

l Schedule, and the Generate Section and Line 

Crea  a
the Proposal List window. 

sal 

• Rclick to see the 
Mouse Button Menu. 

• Click Addendum 
List. 

To run the Proposal Schedule Report,  

• Rclick to see the Mouse

• Click Run Process  

Click Generate P

 

 
A
th

 

ati g Addenda in PES 

Once a Proposal has been advertised, then all futu
m

R
N
Preliminary Detailed Estimate, the Proposa
Numbers (Inquiry) reports to do this accurately. 

te n Addendum, from 

• Click the propo
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A window listing all addenda 
for the proposal will open.  First 
create an Addendum Header 
and then add Addendum items. 

 

To a der 

white space to see the 
Mouse Button Menu.  

• Click Add. 

r is 
auto t
commencing with 0001.   

f the 
Addendum
MM/DD/YY format. 

, 

m 
e 

Button Menu. 

• 
Items. 

 

 

 

 

cre te an Addendum Hea

• Rclick anywhere in the 

 

The Addendum Numbe
ma ically assigned, 

• Enter the Date o
 in 

• Enter a Description up 
to 60 characters in 
length. 

• Click OK when done. 

 

Adding New items 

To add the Addendum items

• Rclick the Addendu
row to see the Mous

Click Addendum 

 



• Rclick in the white 
space to see the Mouse 
Button Menu. 

• Click Add. 

• Click New Item to add 

Oth h

In this example we will add an 
em. 

cting 

• 
n 

• o. 
s not already 

ecall that Project Item Line 
 generated 

m 
item n am
Estimate and select an appropriate line num

• ber from the drop down arrow, which opens the Master Pay item file. 

ed item. 

• Proposal Line Number.  Examine a copy of the Proposal Schedule and determine where 
the item should be displayed, and enter an appropriate number.   

hen these steps are completed,  

• Click OK if there is only one item to Add or 

• Click Add More if other items are to be added. 

an item to the proposal.   

er c oices are: 

Add>Modify item 
Add>Remove item 

it

On this screen enter in 
sequence: 

• Project No., by sele
from the down arrow. 

Category Number by 
selecting from the dow
arrow. 

Project item Line N
that doe
exist.   

R
Numbers are initially
in steps of five.  These gaps 
allow the insertion of addendu

s i  their logical order.  Ex

A Pay Item Num

ine the project worksheet or a copy of the Preliminary Detailed 
ber. 

• The Quantity for the add

W
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Modify 

If the ad
one or m se 
Add

In th w

• 
m the down 

• 

t Line 
e List 

 (the Pay item and 
e now identified). 

• antity. 

 other item quantities are to change. 

 

Del n

If an ite
choose emove Item 

 as all other fields on the window are blue. 

Add d  in the Proposal Folder.  The Addendum 
item W

Existing Items. 

dendum is to modify 
ore item, choo

>Modify Item above. 

is idow: 

Click the Project 
Number fro
arrow. 

Click the Category 
Number from the List 
Box 

• Click the Projec
Number from th
Box
Proposal Line Numbers ar

Enter the corrected qu

• Click OK or Add More if

eti g items 

m is to be deleted, 
Add>R

above.   

In this window in sequence 
Click: 

• Project Number from 
the down arrow 

• Category Number from 
the down arrow 

• Project item Line 
Number from the down 
arrow. 

The deletion is now fully detailed,

en um items WILL NOT show in the Items Tab
s ILL show on the Proposal Schedule Report. 

 



Generating the Proposa
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l Addendum Report 

rom 
osal List 

• 
enu. 

• 
ndums 

Submit

 

If any changes to a Project or Proposal are made after it has been initialized in LAS, the Proposal 
wil

 

ending the Proposal to LAS 

 send the Proposal to Contract Administration for Letting the Control Group on 
ts should be changed to be the Contract Administrators Control 

ld notify the Contracts Office so they can initialize the Proposal in 
 attach it to a Letting.  Once the Control Groups are changed, the Estimator will no 

Proposal or its Projects.  If Addenda need to be added to the 
inistrator will need to change the Control Group on the Proposal 

ator’s Control Group. 

 

Ru i sis Report in LAS 

Because of the confidentiality of the Estimate, it may be the Estimators responsibility to run the 
Bid Tab Analysis report in LAS. 

To star

• k the LAS Icon on the Citrix Screen. 

To produce the Proposal 
Addendum report: 

• Click the Proposal f
the Prop
window. 

Rclick to see the Mouse 
Button M

• Click Run Process 

Click List Proposal 
Adde

• Click OK. 

 the process. 

l need to be re-initialized in LAS. 

S

When it is time to
the Proposal and the Projec
Group and the Estimator shou
LAS and
longer be able to access that 
Proposal, the Contracts Adm
back to the Estim

nn ng the Bid Tab Analy

t LAS,  

DblClic

• Enter the PES/LAS UserID and password. 

• Click OK. 
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LAS will open in much the 
same manner as PES. 

Open the Bid Letting list 
win w
butto  
envelop

Then  

• red 
use 

• Proposal 

• Click Run Process. 

enerate Bid Tab Analysis. 

 

 

do  by clicking on the 
n that looks like an 

e.  

Rclick the desi
Letting to see the Mo
Button Menu.  

Click Letting 
List. 

 

 

The Letting Proposal list 
window will open. 

 

 

 

 

• Rclick the desired 
Letting Proposal to see 
the Mouse Button 
Menu. 

 

 

 

• Click G

• Click OK. 
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For the first run, select all re
including the Engineer

ports 
’s Estimate. 

w the 
eports in 

' prices.   

k Submit. 

 

The sec n the reports, do 
not check In timate. 

This second set of reports will be given to 
inistration Office.   

• Click Submit. 

hen the situation arises that bids are to be rejected and a contract is to be re-advertised the 
Office.  Certain fields in the Letting process will be re-set to 

dicate that the bids are being rejected and the contract re-advertised. 

he Old Proposal Header 

• trol Groups of the proposal and all associated projects from 
 CD##, or from CT## to CD##, as the case may be, so that the district estimator 

who created the Proposal Header will be able to update the projects and create a new 
he re-advertisement. 

District Estimator 

• From the Proposals List window, highlight the proposal to be modified. 

• From the right mouse button menu, select Tabbed Folder Change.   

single or double down arrow to remove the project(s) 
oposal.   

• After removing the project(s), close the proposal and save the file.  This process makes 
the project(s) available to be attached to a new Proposal Header. 

• Change the Access Control Groups of the proposal from CD## to CL##, or to CT##, as 
appropriate.  The old proposal header will then be available in the appropriate contracts 
administration office for history purposes. 

This set of reports will sho
Engineer’s Estimate on the r
comparison to the bidders

• Clic

 

ond time you ru
clude Engineer’s Es

the Contracts Adm

 

Rejecting Bids 

W
process will begin in the Contracts 
in

 

T

Contracts Office 

Change the Access Con
CL## to

Proposal Header for t

• Go to the Projects tab and select the 
from the pr
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• When the Save confirmatio

 

n message opens, click YES. 

 that may be necessary.  Particularly, if there were any 
addenda to the original proposal, enter all changes into the projects before re-advertising the 
pro sa

he New Proposal Header 

select Tabbed Folder Add from the right mouse button 

ial feature for projects, categories, and proposal can 
r, it is important to NOT use the Copy Special feature.  

roposal had addenda attached to it, the number of the last addendum 
issued, would be recreated on page 2 of the new Proposal General tab.   

ew Proposal general tab window appears: 

o Click the page 2 radio button,  

posal Number into the Prev. Let As ContID field.  

cts Tab, Select any additional project or projects to be connected to the 

 button at the bottom of the window. 

•

 

The Projects 

Make any changes to the projects(s)

po l. 

 

T

• From the Proposals List window, 
menu.   

• In many cases, using the Copy Spec
save steps.  In this case, howeve
If the original p

• When the n

o Go to the Cntl PCN: field, and from the list box select the lead project. 

o From the Menu Bar, choose Edit > Import Controlling PCN data. 

o Enter the new Proposal Identifier (“E” Number). 

o Enter the Old Pro

o At the Proje
new Proposal Header.  Click the single up arrow.   

o Click on the Items tab.  A warning window will open indicating that changes have 
been made to the proposal Click OK. 

o Click the Generate Section and Line Numbers

o The reconstructed proposal Item information will appear in the Items tab. 

 Save and close the tabbed folder by clicking on the "X" for the tabbed folder window. 
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Ap

ASHTO American Association of State Highway and Transportation Officials.   

The numerical rating of the vendor's capability to perform work.  It is a factor in 
 

ntrol Group Each user and each project and contract can be assigned a Trns•port 
ontrol group code.  A given user only has access to those projects and contracts that have the 

r.  (See Control Group)  

Ac u
This nu ld be the same as the contractor's vendor number (as maintained in the Vendor 
file) or the Contract ID 

Accou  
Trns•po

Accou r projects.   

Ac i n time is available to procure long 
lead-tim

Action um item.   

Active many) that commands will affect.   

Active Wi ssibly many) that commands will affect.   

Adden hrough 
modifications called addenda.  Addenda allow modi
change
planholder the changes in their bids.   

Adden

Addendu

Addendum Number 

Addendum Project Item Line N   A unique sequential identifier for an item within a 
pro t , 

rns•port fills in the Project item Line Number list with all Project item line numbers for the 
selected project and category. 

Additional Vendor Name A field for an additional name of the vendor.   

Add-On An adjustment to the pay items of a contract after the award is made.  This adjustment 
is something other than a formal supplemental agreement.   

Address Sequence Number A sequential number used to identify one of multiple addresses 
for a single vendor.   

Address The address of the district, area office, field office, or residency.   

pendix A Glossary 

A

Ability Factor 
calculating the vendor's capacity; it is not a performance evaluation.  See also Adjusted Net
Worth and Capacity.   

Access Co
c
same control group as the use

co nt Number The account number of the contractor who is setting up a securities account.  
mber cou

number, depending on the Trns•port installation setting.   

nting Fund Code The accounting department's code for a fund when it differs from the
rt code.   

nting Project Number A code the Accounting department can enter fo

qu s. Time Available to indicate to bidders that acquisitio
e items such as mast arms or other items needing to be fabricated. 

 The type of action (add, change or delete) to be performed by an addend

 Project The open or highlighted project (of possibly 

ndow The open window (of po

dum After sending proposals to planholders, handle subsequent changes t
fications directly into the system to apply 

s to the proposal information before the bid letting.  Send a copy of each addendum to 
s as soon as possible so planholders can incorporate 

dum Date The date the addendum is added or becomes effective.   

m Description A short description of the proposal addendum.   

The sequential number identifying a proposal addendum.   

o.
jec .  Choose a value from the attached drop down list.  When you select a category number

T
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Address Type A coded value indicating the type of address for the vendor (for example, 
billing or shipping) when a vendor has multiple addresses.   

of its debts.  

be 
table) indicating the percent to be used for any additional adjustments.  

eing applied to the item.   

eld 

unts for contractors, 

dge 

eparate item code 
ber is 

ocuments. 

 

 some electronic or manual system 
ith that external 

mber or code for a vendor.   

The total amount presently due for payment to the contractor for a given 

Adjusted Net Worth The total value of the vendor’s assets minus the total value 
This number can represent the agency’s estimate, the vendor’s claim, or an audit amount.   

Adjustment Code Not in use by the Department at this time.  A coded value (which must 
in the ECTGPCT code 
The adjustment fields act like E&C percent (for example, gross receipts tax percentage).   

Adjustment Item Changes to a construction contract item after award, which can include 
incentives, disincentives, and liquidated damages.   

Adjustment Percent Not in use by the Department at this time.  A percent adjustment made to 
the category, which is applied to the total category construction cost to compute the total 
category amount.   

Adjustment Type Code A coded value (from the ADJTYP code table) indicating the kind of 
price adjustment b

Advance Account If your state allows contractors to set up accounts for contractors, this fi
holds that number.  It is not used for any Trns•port processing.   

Advance Account Number If the state allows contractors to set up acco
this field holds that number.  It is not used for any Trns•port processing.   

Affiliate Vendor Number The name of the vendor associated with another vendor.  All 
references to vendors are validated with the Vendor file.   

Affiliates Two Vendors that are legally related to one another in an ongoing way.  The 
Affiliates can be parent and subsidiary, or substantial owners of each other’s stock.  Two 
Vendors who engage in a single joint venture are not considered Affiliates.   

Agency A specific agency that provides funding for a specified purpose (for example, bri
rehabilitation).   

Alternate Item Number ID Not in use by the Department at this time.  A s
used in public documents or in communication with other systems if the regular item num
inappropriate.  For example, the regular item code might be too specific for public d

Alternate Project ID Not in use by the Department at this time.  A code that identifies a 
project in some electronic or manual system outside of Trns•port.  Trns•port can use this value to
communicate with that external system.   

Alternate Vendor ID A code that identifies a vendor in
outside of Trns•port.  This value can be used by Trns•port to communicate w
system.   

Alternate Vendor Number An alternate identification nu

Amendment Another name for an addendum.   

Amount Due to Date 
project.   
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Amount Encumbered The dollar value of securities being withheld by the state to cover 
retainage requirements to date for a contract or vendor (see Securities Account for a description 

is value might not be meaningful.   

 the project (measured in 

pe 
te.  

ent partition by variations in asphalt prices.   

 

).   

 

Pay 
."  

eld tells Trns•port to assign project categories 

of the agency's options).  This is the amount withheld from payments if there is no securities 
account or if the securities account had insufficient funds.  The total of all Amount Encumbered 
values for a particular securities account is limited by the current value of securities on deposit in 
the account.   

Amount Further Subbed (Actual) The dollar value of all child or "sub-subcontracts" of a 
subcontract, which is based on the actual amount agreed to by the subcontractor with the sub-
subcontractors.  Because the actual agreements between subcontractors and their sub 
subcontractors might not be known to the agency, th

Amount Further Subbed (Contract) The dollar value of all child or "sub-subcontracts" of a 
subcontract, which is based on the contract prices for all items.   

Amount The amount of the transaction.   

Approval Date The date the vendor was approved for work.   

Approval Flag A notation indicating the acceptability of the vendor to work on the contract.   

Approximate Percent of Project Length The percentage of
physical length or size, duration, dollars, or other characteristic of choice) that occurs in the 
indicated county, city, or congressional district.  This value is used to estimate the value of 
projects in selected geographical areas.   

Area A portion of the state that consists of one or more counties in their entirety.  Each Area 
belongs to exactly one Area Type.   

Area Type A specification for partitioning the state into Areas.  The Areas in an Area Ty
must be disjoint (have no overlap) and, when combined, must include every part of the sta
Different Area Types partition the state in different ways for different reasons; for example, Area 
Type "Steel" might partition the state by variations in steel prices while Area Type "Asphalt" 
would be a differ

Ascending List order such that the first character of each successive list element has a symbol
that occurs later in the alphabet or number system than the preceding element.  The list of 
numbers 10, 20, 40 and the list of codes A25, C11, Z44 are in ascending order (see Descending

Authorization An official authorization approval of a recommendation.   

Authorized Payment Limit The maximum amount that can be paid to a contractor for a given 
project.   

Automatic Payment (Auto-Pay) Item Items, such as mobilization, with set schedules for
voucher payment as determined by the basis of work on a contract.   

Automatic Payment Specification The rules governing the rate of payment of Auto-
Items.  Typically of the form "When the contract reaches X% complete, pay Y% of the item

Automatic Section Assignment Flag This fi
to proposal sections automatically or do it manually by entering section numbers in the category 
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records.  The default value is Y, which means Trns•port will automatically assign categories
sections.   

Auto-Pay Item See Automatic Payment Item.   

Average Pavement Depth The average depth of the pavement in the roadway portion of the 
proposal.   

 to 

 

ids 
ristics.   

to help generate bid-based 

ed for a contract.   

al of 

ber of the winning bidder for a contract.   

r's 
cluded in the bid.   

e is "0".  Do not 

Status Indicates if the automated bid editing process detected any errors in the bid 

 reads all bids for specific 

g.  

Average Pavement Width The average width of the pavement in the roadway portion of the
proposal.   

Average Price The weighted average unit price bid for a particular item.  The item b
analyzed will usually be grouped according to similar proposal or proposal item characte

Average Unit Price (AUP) Work Type Used to determine average unit prices.  One of nine 
work types related to a specific project.  Trns•port uses this field 
prices for the project items.   

Award Contract Amount The dollar amount originally award

Award Date The date a contract was actually awarded to a contractor.   

Award The contracting authority's acceptance of a bid subject to the execution and approv
the contract.   

Awarded Amount The dollar amount awarded to the winning bidder for a proposal.   

Awarded Vendor Number The vendor num

Batch A computer process that runs by itself with no user interaction.   

Beginning Termini Defines more precisely where the project is taking place with notation 
defined by your agency.  This data, which is printed on some reports, is passed to Trns•port 
BAMS/DSS to pinpoint the project on maps.   

Bid A sealed written instrument conveyed to the Department by a bidder that details the bidde
offer to handle the construction work outlined in a proposal for a price in

Bid Alternate A portion of a proposal that contains two or more groups of items for which the 
bidder must bid on at least one of the group.   

Bid Bond A dollar amount required to bond contractors.  This field is printed on some 
Trns•port reports but not otherwise used in any processing.  The default valu
change it. 

Bid Edit 
(such as incorrect arithmetic).   

Bid Letting An event at which a Department staff person opens and
proposals, determines the winning bidders, and awards contracts.   

Bid Letting Control Number The value Trns•port uses to uniquely distinguish the bid lettin
It does not need to relate to other Trns•port data values in any way.   
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Bid Letting Package A group of proposals processed in a single bid letting.  After you define
proposals, 

 
assign them to a bid letting package.   

s (brief written comments) about a particular 

equence Number A sequential number Trns•port generates whenever you add 

 Prices Unit prices for work items that are derived from estimated historical bid 
erated 

port 
tion in the VENDADDR file.   

rticular 

eet.   

ect.  It 

mber identifying the breakdown item.  This is 
ber is 

. 

Breakdown Type A code table indicating the plansheet might be of a certain type or contain 

from the attached BRDGTYP code table that indicates the type 

ded amounts or sums 
vendor section totals according to an installation option.  This figure should be the same as the 
Proposal Bid Total.   

Bid Note A description field to store textual note
bid for a letting.   

Bid Note S
notes about a bidder.   

Bid-Based
prices.  This process uses either regression or weighted averages that are based on data gen
by the Trns•port BAMS/DSS PEMETH model.   

Bidder A vendor who submits a bid on a proposal.   

Bill-to Address Number The sequence number of the planholder's billing address.  Trns•
references the address informa

Bi-Weekly Estimate The estimate the engineer generates every two weeks for a pa
project.   

Break Item Quantity The recorded quantity of a work item at the plansheet level.  These 
quantities will be rolled up to the estimate item level.    

Break Item The portion of a regular/structure/sewer item assigned to a particular plansh

Breakdown A detailed description or graphic of a section of work performed in the proj
can contain sketches, items, and quantities.   

Breakdown ID 
"1" does not appear, enter a value of "1".   

Breakdown Item Line Number The line nu
usually a number sequenced for the items within a single breakdown.  This num

A unique identifier for the breakdown within a project.  If the default value of 

differentiated from the Project Item Line Number, which may include more than one Breakdown 
Item Line Number.  This field can be entered automatically.  See “Assigning Line Numbers"

Breakdown Item Quantity Enter the quantity for the Item. 

certain data (for example, roadway, bridge, structure or sewer).   

Bridge ID A unique identifier for a bridge structure.   

Bridge Length The length of a bridge.   

Bridge Type A value selected 
of bridge (e.g., Overpass, Trestle Low, etc.). 

Bridge Width The width of a bridge structure.   

Calculated Bid Total Trns•port calculates the vendor bid total by checking various figures on 
the vendor's bid tabulations.  Trns•port calculates and sums item exten



Reference Manual for Production Projects & Proposals PES Release 5.7a                                         Page 93 of 129 

Call During a bid letting, the person in charge of the letting calls each proposal in a pre-specified
order so bidders can submit their bids.  For bid let

 
tings, the terms call and proposal are often 

ust appear in the CHRG code table) indicating 

e agencies with the same participation.  Each 
).  Associate each category with a 

s for a single structure into a single 

possibilities.    

 the code for a percent to be used for any additional adjustments.  The adjustment 

ust be in the ECTGPCT code table)  

 

 
egory but not both.  The code you enter here indicates 

 

y the system; should contain 
rk Class field for the Maintenance 

tion from the Category Work Class description. 

ength among categories so that the combined 
 in miles or kilometers.  The default value is 

used interchangeably.  Trns•port identifies each call by a three-digit number.  Many reports in 
Trns•port LAS list proposals in call order.   

CAS Contract ID The label used to identify proposals to be combined into one contract.   

Cash/Charge Code A coded value (which m
the method by which the plans were purchased.   

Category A subdivision or grouping of items within a project.  Each category represents a 
collection of related work items that have the sam
category can have one or more funding sources (funds
particular unit of work in the project; that is, group all item
category.  Each category should contain items belonging to the same class of work and E&C 
percentage.  Use categories to group items by alternate design 

Category Adjustment Code A coded value (which must be in the ECTGPCT code table) 
indicating
fields act like E&C percent (for example, gross receipts tax percentage).   

Category Adjustment Code A coded value (which m

Category Adjustment Percent A percent adjustment Trns•port will make to the category.  
Trns•port applies this percent to the total category construction cost to compute the total category
amount.   

Category Alternate Code Different categories can be alternates for each other, which means
that a bidder can choose to bid on either cat
that this is an alternate category.  The first two characters specify the alternate group and the 
third character specifies the alternate number.  The Category Alternate Code field and the 
Federal Construction Class field control the generation of section numbers for the proposal.  If 
categories have the same Federal Construction Class and Category Alternate Code, they will be 
combined into a single section.   

Category Depth The average pavement depth in inches/cm.  

Category Description A short description of a category’s purpose (e.g., funding agencies) 
used as default label for proposal section description.  Required b
the code description that is found with the Category Wo
Activity Number chosen.  Enter the descrip

Category Length The length of the category in miles or kilometers.  This quantity will be 
printed on some reports as an overall project length.  You may assign the full length of the 
project in any category, or you may split the l
length is equal to the overall project length.  Enter
0.0000. 

Category Number A four digit number Trns*port uses to identify the category.  Enter the 
Category Number from the list box.  A range may be entered all at once. 
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Category Width The width of the portion of the project represented by a given category.  The 
default value is 0.0000. 

Category Work Class A value selected from the attached CWRKCLS code table that 
indicates the kind of work performed in a category.  For Maintenance projects, use the 

e 
he type of federal work performed in a 

 

 none, some, or all 

n 

 
tion, and proposal section number. 

YES.  Do not change this 
e 

 Like 

em 
e 

.  Trns•port will combine items if the item code (if filled in) is the same and if the 
e 

ria must reside in 

appropriate Maintenance Activity Number in the list box. 

Catg. Suppl Work Code Similar to the Federal Work Category except that Trns•port uses th
FEDSUPP code table.  A coded value indicating t
category. 

Change Order A written order issued by the engineer to the contractor.  It covers permissible 
adjustments and minor plan changes or corrections, rulings with respect to omissions, and
discrepancies or intent of the plans and specifications.  It does not include any extra work or 
other alterations covered by the supplemental agreement.   

Check Box A dialog box component that allows selection of options.  Select
of the available check boxes (see Radio Button and List Box).   

City The city in the district address.   

Classification Function A coded value indicating the classification or category into which 
the item fits.  Used by Trns•port BAMS/DSS to group items into the same market share.   

Clerk Writing Order A coded value indicating the person who took an order for the purchase 
of plans.   

Clicking Pressing and releasing one of the mouse buttons, usually the left button.   

Combine Flag Trns*port will take several different category items and combine them into a 
single proposal line item under certain conditions.  To stop Trns*port from doing that, enter a
`N' for this field.  That will force Trns*port to create a separate proposal line item for this 
category item.  Trns*port will combine different category items into a single proposal line item if 
they match in five fields: the item number, the supplemental description, the item alternate code,
the supplemental proposal descrip

Combine with Like Categories The default value for this flag is 
flag.  Trns•port can combine several categories into a single proposal section according to som
simple rules.  If you do not want that to happen, force Trns•port to put all the Items in this 
category into their own proposal section.  If the check box is marked, then Trns•port combines 
all the Items into a single proposal section.  This field in conjunction with the Combine with
Items flag controls the rolling up of item quantities for bidding. 

Combine with Like Items Trns•port combines category items into a single proposal line it
if they match in four fields: the item number, the supplemental description, the item alternat
code, and the supplemental proposal description.  If you check the Combine with Like Items 
check box, each item will only appear once in the proposal, even if you list it in more than one 
category
alternate code and supplemental descriptions match exactly.  If you remove the check from th
check box, Trns•port will not roll up the items.  Items that meet these crite
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categories that have the same federal construction class (proposal group) to be rolled up into the 
same section of the proposal. 

button.   

on Date See Specified Completion Date.   

 to be 
ou 

ns•port will assume that you mean 

e identifiers the agency will use for this 
Trns•port requires.  Trns•port does not use this field in 

his 

ort processing.   

ct or Central 

n needed to manage 

 

code table, that you use to store 

k 
 

indicates the class of contract. 

Command Button Part of a dialog box that executes a command when you choose the 

Commitment Amount The total dollars committed to the DBE/WBE vendor.   

Common Unit of Measure A coded value from the attached UNITS code table indicating the 
common unit of measure to which Trns•port can convert the item for comparison to other items.   

Completi

Construction Engineering Percent (C & E Pct) Not in use by the Department at this time.  
The default value is 0.00.  Do not change it.  The amount of construction engineering work
performed on a project expressed as a percentage of the total category or project amount.  If y
put a zero in the Construction Engineering Percent field, Tr
0%.  Trns•port leaves the field blank by default and assumes the C&E percent is the same as for 
the project as a whole.  

Cont Alt ID 1 Use this field and Cont Alt ID 2 to stor
contract in addition to the Contract ID 
any Trns•port processing.   

Cont Alt ID 2 Use this field and Cont Alt ID 1 to store identifiers the agency will use for t
contract in addition to the Contract ID Trns•port requires.  Trns•port does not use this field in 
any Trns•p

Contract ID A unique identifier for a proposal or contract.  Enter the planned Distri
office Contract number, and use it as a Proposal Identifier.   

Contract Proposal See proposal.   

Contract The written agreement between the contracting authority and the contractor that sets 
forth the obligations of the parties, including performance of work, furnishing of labor and 
materials, and basis of payment.  Trns•port creates a contract from a proposal when you let and 
award the proposal.  The contract contains all the proposal informatio
construction and pay for construction work.  Like proposals, contracts consist of projects and 
sites.  Contracts also contain item payment information, voucher information (including 
retainage and liquidated damages), contractor performance and schedule information, and 
subcontract and DBE/WBE commitment information.  You can modify the contract as the work
progresses (see add-on, supplemental agreement, and change order).   

Contract Type A value selected from the attached CONTTYP 
a classification of the type of contract this proposal will become (e.g., a maintenance contract).  
Trns•port prints this field on some reports but does not use it in processing. 

Contract Work Type A coded value your agency can use to store a classification for the wor
type for this contract.  For Maintenance contracts, leave the default value "I" – Other.  For other
contracts, choose a code from the list box. 

Contracting Classification A value selected from the attached CONTCLS table that 
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Contractor Bid A bidder's offer to perform the work in a proposal for specific unit prices 
specified by the contractor.   

Contractor Info A contractor that submits a response to The Department's proposal and offers 
to perform the work for specific unit prices.   

Contractor The winning bidder to whom you award the contract.  Any business entity that 
interacts with The Department; for example, bidders, contractors, subcontractors, material 
suppliers, escrow agents, railroads, utilities, and consultants are all contractors.   

Control Group A group of users who can access the same set of projects, proposals, or 

es 

ally enter the control group of the user who signed on and added the 

l 
rol groups (*1, A* or *) will be able to view, change, or delete the 

 

 control group in the field and save the project, only users with a * 

ands that change the 
ow.   

 

r plans, 

s of complete plans 

ocuments, exclusive 

.  The default is $0.00.  The next fields—Cost of 
 

contracts (e.g., only users in the Estimates control group can access Estimates projects).  Each 
control group member may only view, change, and delete projects, contracts, or proposals in 
their own control group.  To pass a project, contract, or proposal to another control group for 
processing, a user can change its control group code to the new group code.  When the user sav
the project, contract, or proposal, the original control group will no longer have access to it.  
Trns•port will automatic
project in the Control Group field.  For example, if an Aeronautics user with a control group of 
A1 adds a project, the project’s control group will be A1 and only other users in the A1 contro
group or less restrictive cont
project.  To pass a project to another control group for processing (e.g., from Estimates to 
Contracts), a user in the first control group can change the control group code to the new code. 
After the first user saves the project, the first control group will no longer have access to the 
project.  If you put a specific
control group (they can view all projects) can access the project and change the control group. 

Control Menu Every window has a control menu, which contains comm
size of, move, or close the active wind

Controlling PCN Indicates which project is the controlling project in a multi-project contract. 
Enter the Financial project Number of the lead project. 

Conversion Factor to Common Units Trns•port multiplies this conversion factor by the 
item quantity to convert the item units to the common unit of measure.   

Cost of Plans Used for planholder invoicing in the LAS module.  If there is a charge fo
enter the cost of the plans only, exclusive of sales tax.  The default value is 0.00. 

Cost of Plans without X-Section Not in use by the Department.  Used for planholder 
invoicing in the LAS module.  Trns•port will bill this cost to purchaser
without cross-references for this proposal. 

Cost of Proposal Package     Used for planholder invoicing in the LAS module.  If the 
district charges for plans, enter the cost of the complete package of bidding d
of sales tax.  This field has a default value of 0.00. 

Cost of Proposal Used for planholder invoicing in the LAS module.  Trns•port will bill this 
cost to purchasers of plans for this proposal
Plans, Cost without X-Section, and Cost Per Plan Sheet—are used for the same purpose.  
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Cost of Specs Used for planholder invoicing in the LAS module.  If there is a charge for 
specs, enter the cost of the specs only, exclusive of sales tax.  Default is 0.00. 

 
ckage only, exclusive of sales tax.  Default is 0.00. 

he 
sents 

lendar days the 
one 

ints 

e 
 

 

 
ems.   

es effective.  Enter in 

mat. 

ate.  Enter in YY/MM/DD format. 

Es and the value of the item portion set-

Cost Per Plan Sheet Used for planholder invoicing in the LAS module.  If the district charges
for plans, enter the cost of the specification pa

Cost Plus Time Bidding A bidding method that involves time with an associated cost in t
low bid determination.  This type of bidding consists of the traditional work items and repre
the total contract amount.  The Time component is a bid of the total number of ca
bidder will require to complete a milestone.  Both the work items and the Cost Plus milest
components appear in the bid proposal and are used to determine the lowest bidder.  The total 
number of calendar days bid by the low bidder for the contract site (Site 00) becomes the 
contract time and the work item bid component becomes the contract total for contractor 
payment.   

Counties Enter up to four counties for each proposal (select from the list box).  Trns•port pr
this information on some reports, but does not use it in processing.   

County Name The county name will be entered automatically after selecting the county 
number. 

County or Congressional District From the list box in the field, select the county to b
added.  Once you select a county, the county number will be displayed and the county name will
appear in the adjacent field.  Do this for each row of data. 

County/City/Cong. Dist Code A coded value indicating that the project or proposal includes
work in a county, city, or congressional district.   

CSV (Comma Separated Value) A type of file where fields within a record are separated by
commas.  Used to transfer data between syst

Current Work The current dollar amount of work the bidding vendor has outstanding.   

Date and Time of Purchase The date and time a vendor purchases a set of plans for a 
particular proposal.   

Date of Addendum The date you add the addendum or the date it becom
MM/DD/YY format.   

Date of Estimate The date you complete an estimate.  Enter in YY/MM/DD for

Date of Letting The date you will hold a letting.  Enter in YY/MM/DD format. 

Date Priced The date you priced an estim

Date The date you entered the status.  

DBE Apply Interest Not in use by the Department at this time.  A percentage indicating the 
average number of times this item is selected for DB
aside for. 

DBE Approval (Flag) Indicates the acceptability of the vendor to work on a contract.   
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DBE Certification Date The date on which you certified the vendor for its business enterp
type.   

rise 

d 
al 

BETYPE code table) indicating 

ight require that a percentage of a project be 

ich 

Set a flag for any vendor in the Vendor file to indicate that the vendor is a 

l of deleting.  Usually deletes one data record from one file, so you will 

t has a symbol 
.  The list of 

 These two lines of data allow you to 

8 
should therefore contain enough information to uniquely identify a project from all 

DBE Commitment Bidders state that if the Department of Transportation awards them a 
particular contract, they will use a particular qualified DBE vendor as a subcontractor or 
supplier.  Bidders also specify the value of work the DBE will perform.   

DBE Disadvantaged Owned Business Enterprise.   

DBE Goals A value selected from the attached DBENOTE code table, that indicates which of 
the two goals described above apply to this proposal.  If you choose NONE, Trns•port will not 
print goals on any report.  If you choose DBE, Trns•port will only print the DBE/MBE goal an
will label it a DBE goal.  If you choose BOTH, Trns•port will print both the DBE/MBE go
(labeled as an MBE goal) and the WBE goal. 

DBE Interest Flag Not in use by the Department at this time.  Indicates whether an item is 
often of interest to or is selected for DBW/WBE set-aside.   

DBE Interest Percent to Apply A percentage indicating the average number of times this 
item is selected for DBEs and the value of the item portion set aside for DBEs.   

DBE/MBE Goal A percentage goal set for disadvantaged (DBE) or minority (MBE) business 
enterprises for a proposal.   

DBE/WBE Code A coded value (which must be in the D
whether the vendor is a DBE, WBE, or MBE.   

DBE/WBE Commitment A contract proposal m
subcontracted to MBEs.  When the prime contractor submits plans to meet these requirements 
(that is, what work item(s) will be subcontracted to which subcontractors), enter and track these 
DBE/WBE commitments in Trns•port.   

DBE/WBE Vendor Number The vendor code for the particular DBE/WBE vendor, wh
must be in the VENDOR file.   

DBE/WBE Vendor 
DBE, a MBE, or a WBE for minority hiring.   

Delete The lowest leve
only see one Delete Warning window.  (See also Power Delete and Strong Delete). 

Descending List order such that the first character of each successive list elemen
that occurs earlier in the alphabet or number system than the preceding element
numbers 40, 20, 10 and the list of codes Z44, C11, A25 are in descending order (see Ascending).   

Description Trns•port prints on most project reports. 
enter a brief description (maximum 120 characters).  When Trns•port lists projects in a scroll 
window, it displays the first 28 characters of the project description with the PCN.  The first 2
characters 
other projects. 
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Designer The city, county, consultant, or squad that designed the project.  Selected from the 
attached STAFF code table. 

ation.  It can contain 
ns, and check boxes.   

the 

AFF code table) indicating the engineer in 

ent.  The account will earn interest for the vendor, but 

 comments or remarks about the estimate.   

he pay estimate on Item Progress and adjustments 

t to produce 

lt 
matically filled by Trns•port PES each time the Preliminary Detailed Estimate 

process is run.   

Detail Window Detail windows allow you to add, change, or browse information about a 
selected project, category, item, and so forth.   

Dialog Box A box displayed on the screen that allows you to input inform
text boxes, list boxes, command buttons, radio butto

District The district where a project or contract is located.  Enter the managing district for the 
project, by clicking on the list box and selecting your district. 

Document Number If the state has an internal referencing number or library system for 
documents, this field would hold that number.  Trns•port does not use it in any Trns•port 
processing.   

Double-Clicking Pressing a mouse button twice in rapid succession.   

Dragging Using the mouse to highlight an area of the screen that is larger than one character.  
Point the mouse to the beginning of the area to highlight and click the left button.  Hold down 
mouse button and drag the mouse until you have highlighted the desired area.   

E&C The percentage of engineering and contingency expenses for a construction project.   

Encumbrance Dedicating funds for a construction project.   

Engineer A code value (that must be in the ST
charge of the district, area office, residency or field office.   

Enter the Financial project Number of the lead project. 

Escrow Account A bank account set up by a vendor in which the Department will deposit the 
money normally retained by the Departm
the vendor cannot make withdrawals until the Department authorizes the bank to do so.   

Estimate Comments Textual

Estimate Info The amount the contractor will receive for the estimated work performed on the 
contract during a pay period.  Trns•port bases t
made for various reasons.  This entity also includes a breakdown of the payments.   

Estimate Numerous estimates are prepared over the life of a project.  Use Trns•por
these three: Preliminary Detail Estimate: Also referred to as the P, S & E Estimate, this report 
provides a project view of costs, including add-on percentages and funding breakdowns.  
Proposal Estimate: Also referred to as the Design Estimate or Engineer's Estimate, this estimate 
contains a list of proposal items and the (estimated) costs.  Final Detail Estimate: Also referred 
to as the Contract Agreement Estimate.  This estimate uses the contractor's bid prices as the 
"estimate."  

Estimated Amount of Project The total estimated amount of work for a project.  The defau
is "0".  It is auto
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Estimated Item Price The engineer's estimated unit price for an item.  Trns•port uses this fie
to determine an item’s cost fo

ld 
r the Detailed Estimate.  Defaults to 0.000, but you can modify the 

ntity of work for an item.   

 

 
d item 

in Trns•port BAMS/DSS to analyze construction overruns.  Used with Estimated 
ine the value of bids, in 

port BAMS/DSS 

is time.  Indicates whether 

d price amount for a line item in the 
 this field in production and Trns•port 

ion.   

the category.  The 
 

ns•port adds 

ral 

 

rticipation Indicates whether a specific fund is a federal fund. 

are not required to, but you may enter information in these fields to record 
additional information about a project. 

value. 

Estimated Item Quantity The estimated qua

Estimated Price Lock Indicates whether you have finalized an estimated item price and it 
should therefore not be modified by users or the system.   

Estimated Price The Department's estimated cost for one unit of an item.  Trns•port uses this
field to determine an item's cost for the Detailed Estimate.   

Estimated Quantity Used with Estimated Price to determine the cost of an item.  Used in
Trns•port LAS to determine the value of bids, in Trns•port CAS to determine the authorize
quantity, and 
Price to determine the cost of an item.  Used in Trns•port LAS to determ
Trns•port SiteManager to determine the authorized item quantity, and in Trns•
to analyze contract overruns.  Defaults to 0.000, but you can modify the value. 

Estimated Unit Price The engineer’s estimated cost for one unit of an item.  Trns•port uses 
this field to determine an item’s cost for the Detailed Estimate.  Defaults to 0.000, but modify the 
value as necessary. 

Exempt from Retainage Not in use by the Department at th
Trns•port should withhold retainage for work performed on a specific item.   

Extended Amount from Proposal The bidder's extende
proposal and section and proposal totals.  Trns•port uses
BAMS/DSS models use it.   

Extra A change to a contract to add additional work items.   

Federal Appropriation Codes A coded value indicating the type of federal appropriat

Federal Construction Class Describes the type of construction used for 
Department can define its own codes and enter them in the FEDCCLS code table.  Trns•port uses
this field to determine whether categories can be combined.  For Maintenance contracts, this 
field will always be “M”.  When you combine categories and Items in a proposal, Tr
categories together if they have the same Federal Construction Class. 

Federal Funding Mark the check box if the fund contains federal dollars.  If you check the 
Federal Funding box, the funding source is a participating fund, which means that the fede
government is participating in funding these category Items.  If you do not check the box, the 
funding source is non-participating, which means that the funding is 100% state or a combination
of state and local. 

Federal Pa

Federal Work Category Not in use by the Department at this time.  It is the same as Category 
Work Class, except the FEDWTYP table is used.  Identifies roadway, structure, or sewer 
groupings.  You 
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Federal/State Project Number The federal or state project number identifying a project, 
proposal, or contract.  Enter N/A for all maintenance projects. 

FHWA The Federal Highway Administration.   

ck box indicates that 

ne Trns•port project.   

 

 

ork and might include state-specified allowances for overhead and profit.  

dgeably.  

 
ccount is not a bid item, Trns•port does not pass it to Trns•port 

tion A short description of the fund.   

 portion of work a particular fund will pay.   

Field Book Not in use by the Department at this time.  If checked, this che
the project is maintained using a field book machine. 

File An entity that stores all information associated with o

Filter A way to quickly locate records in Client/Server Trns•port list windows.  You can specify
search criteria to find a group of records.   

Finance Code Letters that usually precede the control section.   

Fixed Price (Pre-Established Price) This indicates that the bidder is required to bid the 
price specified by the Department.  If you set this flag to "Y", the Estimated (or Revised) Price of
the item will appear already filled in on bidders' proposal schedules.  The default value for this 
field is "N".   

Force Account An item of work the Department pays at the contractor's cost rather than at a 
bid price.  A force account includes the materials, labor and equipment the contractor actually 
uses to perform the w
State-specified schedules usually determine labor and equipment costs rather than the 
contractor's actual payments.  You will typically use force account items when there is 
uncertainty about the work involved for the item and you cannot bid it knowle
Examples include utilities relocation and toxic waste removal.  Because you pay the item at cost, 
the unit of measure is dollars.  Therefore, you often estimate force account items as if they were
lump sum.  Because a force a
CAS or Trns•port BAMS/DSS.   

Fuel Adjustment Type A coded value indicating that an item might require a fuel price 
adjustment.   

Fund Assign funding sources at the project, category, and item level.  Typically, you specify 
funding sources at the category level; however, specify default funding at the project level and 
identify individual items as nonparticipating in category or project-level funding sources.  The 
funding defined for a category can consist of multiple sources with funding limitations and 
priorities established for each source.   

Fund Code A unique identifier for a funding source.   

Fund Priority Order A sequence number you use to indicate the order in which you should 
encumber funds when certain funds have limited participation.   

Funding Descrip

Funding Group An identifier used to associate funds into groups.   

Funding Participation Limit The maximum amount, in dollars, that a fund will pay for this 
category.   

Funding Participation Percent The
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Funding Prefix An alternate name for a fund.   

General Description/Comment A short description or written comment about the particular 

If you use a generic field, you can redefine 
e contents or 

g until you shade the desired area.   

ice The price that you have historically used for an item.   

   

 day by 

both.  The first two characters of the item 
t.   

  
f 

ure as the other items in the item class.   

/structure/sewer item to the material that 

  It is contained in the 

med between successive 

ary A particular, quantified part of the work in a proposal.  If the work quantity is 
mmary 

DBE/WBE vendor.   

Generics Extra fields Trns•port does not use in any processing.  These fields will only appear 
on reports that you have customized to include them.  
the field description (that is, the field label displayed on the window) to indicate th
use of the field.   

Highlight To shade an area to change its appearance.  Highlight with a mouse by pointing and 
clicking on the beginning of the area and draggin

Highway Number The identifier for the highway being worked on in a project.   

Highway Type A coded value indicating the type of highway (for example, asphalt, concrete, 
or dirt or two-lane or four-lane limited access).   

Historical Pr

Icon A symbol representing an application in the Microsoft Windows operating environment.  
Icons might or might not be active.  An icon’s name is the same as the application it represents.

Increase/Decrease A modification of a regular/structure/sewer item's authorized quantity as 
specified by a recommendation.   

InspDailyRpt (Inspector's Daily Report) A written report generated every working
an inspector that describes the work performed on a Contract monitored by that inspector.   

Invoice Number A unique identifier for a planholder invoice.   

IRS Number The Federal Employer Identification (FEI) number assigned to the vendor by the 
IRS.   

Item Alternate Code Different items can serve as alternates for each other, which means that a 
bidder can choose to bid on either item, but not 
alternate code specify the alternate set and the third character indicates the choice within the se

Item Classification Function A coded value indicating the classification or category into 
which the item fits.  Used by Trns•port BAMS/DSS to group items into the same market share.
Caution: When you assign an item classification to an item, be sure that the item has the same unit o
measure or the same common unit of meas

Item Material Information and factors linking a regular
comprises the item.   

Item Number The Item Number from the Master Pay Item List.
ITEMLIST code table of Trns•port. 

Item Progress The quantity of a regular/structure/sewer item perfor
measurements or estimates made by the Department inspectors or engineers.   

Item Summ
not measurable, Trns•port sets the quantity to 1.00 for the lump sum item.  An item su
contains the dollar value of all work in a proposal.   
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Item The smallest unit of work identified within a project.  Items can represent biddable work or 

in a project.   

ay distinguish these lists by a spec year.   

ong 

 

 which you will open a bid for a specified proposal during a 

ttings in the districts, allocate 
onth, and two for the date.  

n should arise that you will hold a second letting on the same date, you may insert a "B" 

posal 

he allowed time for a contract.  This has a default value of "1" and will not 
s table 

.  
k 

non-biddable work such as rights-of-way and force accounts.  You can define groups of items to 
represent alternate design possibilities and you can divide the quantity of work for an item across 
multiple categories with

Item year Because Trns•port contains projects designed at different times, you may not change 
the reference information about each item (such as description and unit).  Doing so would change 
the meaning of projects already in progress.  Instead, create new reference item lists when 
necessary.  You m

Last Addendum Number The last addendum number used for a proposal. 

Last Description Number Filled in automatically by Trns•port when you enter l
descriptions.   

Last Revision Date someone last revised the estimate.  Enter in YY/MM/DD format 

Latitude of Address The latitude on a map of the vendor's address.   

Latitude of Midpoint The default value is 650000, and may be changed as appropriate.  Enter
latitude in the form degrees, minutes, seconds.   

Letting Address A description of the letting location.   

Letting Call Order The order in
bid letting.   

Letting Number A unique identifying number or alphanumeric for a letting.  It may be 
composed of any combination of eight numbers and letters.  For le
two positions for the district number, two for the year, two for the m
This will be in the form of ##YYMMDD, where ## represents the district number.  If the 
occasio
in position seven.  The Central Office lettings commence with a prefix of CT.   

Letting Proposal Call Order The order in which you will open a bid for a specified pro
during a bid letting.   

Letting Status of Proposal A coded value indicating the status of a proposal.   

Lien/Claim A statement by an individual or company that they are owed a payment because of 
conditions caused by the contractor's work or performance.   

Liquidated Damages Per Day The amount to be charged, in whole dollars, for each day that 
a contractor exceeds t
be used in preparing bidding documents.  Trns•port cannot handle the liquidated damage
contained in the Standard Specifications for Road and Bridge Construction. 

List Box Part of a dialog box that contains a list of choices.  Select one of the choices at a time
The list box will have a scroll bar to help you move through the list (see Radio Button and Chec
Box).   
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List Window A list window contains a list of records relating to a particular process (for 
example, Projects).  From a list window, select a specific record and open a detail window that 
contains the fields and data associated with the record.   

Location of Bid Deposit The location at which bidders should deposit bids.   

 of the item (maximum 60 

 Address The longitude on a map of the vendor's address.   

riate.  

the item has alternates or is an alternate, only 

in the project but 

unding.   

Location of Letting The location at which bids will be opened.   

Location The site where work is being performed for the proposal.   

Long Description 2 A continuation of the long description
additional characters, if needed).   

Long Description A long description of the item (maximum 60 characters).   

Longitude of

Longitude of Midpoint The default value is 1650000, and may be changed as approp
Enter longitude in the form degrees, minutes, seconds.   

Low Cost Bid Item Flag Generated by Trns•port in the Bid Tab Edit process, this flag 
indicates whether the item is a low-cost item.  If 
one of the alternates will be flagged as the low-cost item.   

Lump Sum Item Units A value, selected from the attached UNITS code table, that identifies 
the type of measurement used to determine the unit of one lump sum item. 

Major Item Flag Indicates that an item is important enough to appear on the Notice to 
Contractors, regardless of the dollar amounts allocated to it. 

Material Any measurable, physical substance used to perform an item of work or the substance 
of the completed item itself.   

Maximum Capacity The maximum amount of work, in dollars, that a vendor can perform.   

Maximum Contract Amount Paid A limit, expressed as a percentage of the original contract 
amount, for an automatically paid item.   

MBE Minority Owned Business Enterprise.   

Menu A list of related commands that you open and view.   

Misc Item Non-standard items added to a project, which you identify as "7000" items.  
Trns•port calls these non-standard items.   

Mouse Hand-held mechanical device used to position the cursor and perform actions on the 
screen.   

Non-Bid Item An item, such as a state-supplied item, that will be included 
will not appear on any bid documents.   

Non-Federal Participating Item An item in a construction project that is not eligible for 
federal f
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Non-Participating Fund Code Identifies a fund that will fund 100 percent of the work 
project item.  Trns•port will exclude the work for this item from funding for the category that 
contains the item.   

for a 

g of a 

he contract work and the 

mpletion of 
 Type of Days field 

 be generated when you generate labels 
 zero 

vision.   

  

 the proposal plans.   

vision is effective.   

s for a project.   

 
he Department breaks down roadway items and bridge items into separate parts.   

 
d work).   

r 

Notice Publication Date The date you will notify potential bidders of the lettin
proposal.   

Notice to Proceed Written notice to the contractor to proceed with t
contract beginning date.   

Number of Days Bid In a Cost Plus Time bid, the bid time number of days bid for the 
associated letting proposal’s awarded vendor for an associated proposal site.   

Number of Days The number of available or calendar days that are available for co
a contract site.  Leave this field blank if you selected Completion Date for the
above. 

Number of Label Sets The number of sets of labels to
for this order.  You must fill in this field for Trns•port to generate labels.  Valid values are
through nine.   

Number of Pages The number of pages of the special pro

Number of Plan Sheets The number of plan sheets purchased by a vendor.   

Number of Spans The number of spans of the structure represented by a category.   

Obsolete Flag Indicates whether the special provision is in effect or obsolete.   

Obsolete Item Flag Indicates that an item is obsolete and should no longer be used on new 
projects.   

Obsolete Vendor Indicates that a vendor is obsolete and therefore should no longer be used. 

Officer's Address Number The vendor address sequence number identifying the vendor 
officer's address.   

Ordered by The name of the person ordering

Originating Date of Specification The date a special pro

OTSH One time shipping address.   

P, S&E Plans, specifications, and estimate

Part A collection of related portions of regular/structure/sewer items in a project.  In a typical
project, T

Partial Payment Item Items for which work occurred during a voucher cycle paid according
to quantity placed (excluding substandar

Passed to CAS/DSS Indicates whether a contract has been passed to DSS (D), CAS (C), o
both (B).   



Reference Manual for Production Projects & Proposals PES Release 5.7a                                         Page 106 of 129 

Password A code Trns•port uses to identify you in conjunction with your user name when you
sign on to Trns•port.  You must keep your password secret to prevent other people from 
accessing your files 

 

without your knowledge.   

ear The Department no longer creates a new pay item list each time a specification 

lly be 
but it might be 

nt Voucher A record of what the payment should be to a contractor or escrow account 

 complete.   

etermines if an item 

100 in the 
00%. 

n 

 

item data from scratch, input data, or modify 

ffice, field 

 where the project work is being 

.  

ow on the screen rests on a desired object.  

lete The second level of deleting.  Deletes multiple records from more than one file, 
so you will see two Delete Warning windows.  For example, if you are deleting a bid letting 
package, Power Delete will delete the letting call, bids, planholders, and proposal.  (See also 
Delete and Strong Delete)  

Pay Adjustment Adjustments applied to contract project payments.   

Pay Item Y
book is issued.  For the foreseeable future, the Specification year and Pay Item year fields will 
remain as "00".  

Pay Quantity The quantity of an item for which a specific estimate will pay.  It will usua
the sum of the item progress quantities performed since the previous estimate, 
different because the Department withholds payment for various reasons.   

Payment Fund A fund and dollar amount that you designate to pay for part of an estimate.   

Payme
for a particular project.  Trns•port generates this voucher for treasury and billings.   

Percent Complete Basis A coded value indicating the method used to determine the current 
percent of work

Percent Complete Threshold A percent of item completion that d
should be paid automatically.   

Percent of Project Length If there is only one county involved in the project, enter 
field.  If multiple counties are involved, enter percentages for each that will total 1

Percent of Quantity Paid The percentage of the current item quantity to be paid to date at a
automatic payment threshold.   

Percent Ownership The vendor's percentage of ownership of the affiliated company.   

PES Worksheet An interactive process that allows users to add items and item level data to
projects quickly.  The functionality is provided through an interactive, spreadsheet-like data 
entry window.  Users are able to enter project 
existing PES item data.   

Phone The phone number (including area code or extension) of the district, area o
office, or residency.   

Physical Road Number The name or number of the road
performed.   

Planholder A vendor to whom you issue a proposal package that is valid to submit as a bid
Courtesy planholders purchase proposal packages on which they cannot bid.   

Pointing Moving the mouse until the tip of the arr
You can place the mouse on a flat surface and slide it to the object.   

Power De
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Pre-Established Price Indicates that the bidder is required to bid the price specified by the 
Department. 

Prequalification Certification Date The date you qualify the vendor to perform the type of 

n Update List Date The date you schedule to review the list of vendors who 

ly 

or 

rocess 

ta in the BAMS/DSS module to determine an estimated price for 
pute 

g district. 

ork to 

non-

port passes this data, which Trns•port prints on some reports, to 

A unique number or alphanumeric that identifies a project.   

quely identify a project 

work certified for the state.   

Prequalification Expiration Date The date the vendor's qualification for certification for 
work expires.   

Prequalificatio
have pre-qualified.   

Previously Let As CONTID Indicates the contract ID under which a proposal was previous
let.   

Price Index A coded value indicating that Trns•port should automatically adjust item prices f
inflation according to the index.   

Price Lock Flag The default value for this field is "N".  There is a Trns*port PES p
called Generate Bid Based Prices which may be used to fill in all the Estimated Prices.  That 
process uses historical bid da
each item.  If you set this field to `Y', the Generate Bid Based Prices process will NOT com
a price for this item, leaving the manually entered price in place. 

Priced by Indicates the person from the attached STAFF code table who priced an estimate.   

Primary DBE/WBE Code A coded value indicating the vendor’s business enterprise 
certification type.   

Primary District The managin

Prime Project Not used by the Department.  A prime project generally represents all w
be performed under a single federal project number.  This work is subdivided into Trns•port 
projects.  Each Trns•port project represents a logical portion of the prime project one project 
might contain all bid items, another preliminary engineering and rights-of-way, and another 
biddable construction work such as force accounts.   

Project Beginning Termini, Ending Termini, Beginning Station, Ending Station 
These fields let you define more precisely where the project work is taking place using notation 
defined by your agency.  Trns•
Trns•port BAMS/DSS to pinpoint the project on maps.   

Project Control Number (PCN) 

Project Description Trns•port prints on most project reports.  These two lines of data allow 
you to enter a brief description (maximum 120 characters).  When Trns•port lists projects in a 
scroll window, it displays the first 28 characters of the project description with the PCN.  The 
first 28 characters should therefore contain enough information to uni
from all other projects.   
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Project Each Trns•port project represents costs associated with all or part of a construction 
project.  The information used to define a PROJECT generally comes from The Department's 

rns•port processing.  Trns•port prints this code on some Trns•port 
n 

 

hen an addendum is being created, you identify an item 

er, Trns•port fills in the Project item Line Number list with all project item line numbers 

ct.   

oject work is being performed.   

 
ues for the PROJTYP table.  Leave this field blank for Maintenance projects. 

m the attached PWRKTYP table.  The Department 

ter 

 the list box. 

 

 funding used for the proposal.   

Proposal Item Each proposal section is a collection of one or more proposal items.  Each 
proposal item is a bid item.  Trns•port constructs proposal items from one or more project items 

Program Planning and Design branches.   

Project Grade Not used in T
reports.  Values entered here must be in the GRADING code table to be legal.  Each agency ca
specify codes that are meaningful to the agency.   

Project Item Line Number A unique sequential identifier for an item within a project.  This is
a four digit number Trns•port uses to identify the item.  Trns•port will automatically enter this 
value when you run certain processes.  W
to be changed by choosing a value from the attached drop down list.  When you select a category 
numb
for the selected project and category. 

Project Item See Item.   

Project Item Sequence Number A unique sequential identifier for an item within a proje

Project Location The location of the primary work performed in the project.   

Project Number Enter the Financial Project (FINPROJ) Number. 

Project Road Name The name of the primary road on which pr

Project Sequence Number A sequential number for each event entered.   

Project Type     A value, selected from the attached PROJTYP table.  The Department
specifies its own val

Project Work Type A value, selected fro
specifies its own values for the PWRKTYP table.  Enter a value in the Project Work Type field 
to run this project through the Bid-Based Prices processes.  Project Work Type is one parame
used to determine the bid-based price.  Leave this field blank for Maintenance projects 

Proposal Addendum Number A sequential number identifying a proposal addendum.  
Trns•port enters a sequential value automatically. 

Proposal Bid Total The total cost of the proposal as determined by the bidder.   

Proposal Call Order The order in which you will open a bid for a specified proposal.   

Proposal Class For maintenance projects enter "I" from

Proposal DBE Goals A code (which must be in the DBENOTE: code table) indicating which 
of the two goals described above apply to this proposal.  If you enter NONE, Trns•port will not 
print goals on any report.  If you enter DBE, Trns•port will only print the DBE/MBE goal and 
label it a DBE goal.  If you enter BOTH, Trns•port will print both the DBE/MBE goal (labeled
as an MBE goal) and the WBE goal.   

Proposal Fund Type A coded value indicating the kind of
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by combining items with the same item code from the same section.  You can override this 
"folding" of similar project items.  Similar project items will create separate proposal bid items.   

Proposal Line Number A unique sequential number that identifies a line item within a 

tract items in the proposal form that show quantities and 
ave blank spaces for bid price insertion.   

ections by 

 Then similar project 

 field will be the 

 

e of proposal (for example, a proposal 

, see 

The number of complete plans without 

proposal.   

Proposal Location The site where work is being performed for the proposal. 

Proposal Notes Available for special notes that need to be communicated to bidders.  Limited 
to 60 characters. 

Proposal Number Held If the state has a serial sequence number or a numbering system for 
proposals, this field would hold that number.  Trns•port does not use it in any Trns•port 
processing.   

Proposal Schedule A listing of con
units of measurement and h

Proposal Section Number A unique sequential identifier for a proposal section.   

Proposal Section Represents a grouping of proposal items.  Trns•port creates s
grouping all categories with the same work class on all projects assigned to the proposal.  You 
can override this "folding" of similar categories into single sections. 
categories will create separate proposal sections.  Trns•port will always assign project categories 
representing different alternates to different proposal sections.  The description
description of the lowest MA number in the project.  This description should be changed to 
reflect the overall project. 

Proposal The entities presented to potential contractors for bidding.  You construct a proposal 
from Trns•port projects.  Typically, you combine multiple projects into a single proposal.  (You
cannot add an individual project to more than one proposal or split it among multiple proposals.)  
Proposal information generally includes contract time specifications, DBE/WBE goals, bonding 
information, a detailed description of the work the contractor will perform, and an identification 
of any necessary special provisions, supplemental specifications, or both.   

Proposal Type A coded value indicating the typ
specifically for small businesses).   

Proposed Letting Date This field is entered from the FM system.  If the date is in error
the Work Program office to have it corrected. 

Qualification Amount The total dollar value of contracts for which the vendor is qualified to 
work.   

Qualification Classes A classification of work for which a vendor is qualified.   

Quantity of Complete Plans The number of complete plans purchased by a vendor.   

Quantity of Complete Plans without Cross-X 
cross-references purchased by a vendor.   

Quantity of Proposals The number of proposals purchased by a given vendor.   
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Radio Button Part of a dialog box that allows you to select one option from a group of rela
options.  Each choice has a circular button (see List Box and Check Box).   

ted 

cess 
  

rized time, 

re/Sewer Item A particular, quantified part of the work in a project (if the 

g 

 will 

hich 
 of the changes you have made to any of the estimated prices.   

king place.   

(for 
r county highway).   

 the value in the Type of Days field is CD or AD.  

of the inconvenience of the construction.   

 or windows.  The bar contains up and down scroll 

 drag the 
scroll box or click the scroll arrows.   

Reason for Non- Processing A coded value indicating the reason Trns•port did not pro
a proposal. 

Recommendation Modification of contract items, such as extending the autho
changing an item quantity, or adding a new item to a project.   

Regular/Structu
work quantity is not measurable, Trns•port sets the quantity to 1.00 for the lump sum item).  
Regular/structure/sewer item contains the dollar value of all work in a project.  This entity 
includes regular items, structure and bridge items, and sewer items.   

Relation to Vendor A coded value indicating the relationship between a vendor and its 
affiliate.   

Retainage The amount withheld from voucher payments made to a contractor pendin
completion of a contract.   

Revised by A coded value indicating the person who revised an estimate.   

Revised Item Price A revised price for an estimate item.  If you enter a value, Trns•port
use it instead of the original engineer’s estimated item price.   

Revised Price Change the Estimated Price by filling in a new value in this field.  Trns•port 
will use the Revised Price instead of the Estimated Price whenever this field is non-blank, w
allows you to keep a record

Road Name The name of the primary road associated with the prime project.   

Road Section Number An identifier for the road section in which construction is taking 
place.   

Road Section Number, Beginning Termini, Ending Termini, Beginning Station, 
Ending Station Identifiers for the road section in which construction is ta

Road System A coded value indicating the road system of which this highway is a part 
example, interstate or federal, state o

Road User Cost Per Day A value used in determining the low bidder in a Cost Plus Time 
bid.  A value can only be entered in this field if
A non-blank value in this field indicates the Site is a Cost Plus Time Site.  The value is the cost 
per day 

Route Number The route number of the road affected by a project.   

Sales Tax Code A coded value indicating the sales tax that applies to the vendor.  The 
Department does not collect sales tax. 

Scroll Bar A rectangular box in list boxes
arrows or left and right scroll arrows and a scroll box.  The scroll bar allows mouse users to 
move through text to view sections that are not currently visible.  To scroll, click and
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Scrolling Move the cursor left or right or up or down to see parts of the text that are not 
currently visible (see Scroll Bar).   

Section Assignment Flag telling Trns•port to assign project categories to proposal sections 
automatically or do it manually by entering section numbers in the category records.  The default 

ion.   

ith the Department so that 

 in Lieu of Retainage Not in use by the Department at this time.  A flag indicating 
ount 

t presently in use. 

•port 
 short 

ain enough 

mber A unique identifying sequence number for each site.  Each contract must have a 

ault 

) as part of a single contract, you can 

ed PRICSPR code table, that indicates the 
istorical).  Defaults to 

 the 

t apply to the revised price, and the source of 

value is Y, which means Trns•port will automatically assign categories to sections.   

Section Description A short description of the proposal sect

Section Number See Proposal Section Number.   

Section See Proposal Section Number.   

Securities Account A contractor can establish an escrow account w
the Department can hold securities in place of retainage.   

Securities
whether you will allow the contractor to deposit securities with the agency to reduce the am
of retainage withheld in payment vouchers.   

Set Aside Proposal A value, selected from the attached SETASID code table that indicates 
you have set aside a proposal for a particular purpose.  Leave blank, this is no

SHA State Highway Agency.   

Ship-to Address Number The vendor address sequence number of a planholder's shipping 
address.   

Short Description A short description of the item (maximum 40 characters).  When Trns
lists items on a scroll window, Trns•port displays the first 30 characters of the item
description beside the item number.  The first 30 characters should therefore cont
information to uniquely distinguish an item from all other items.   

Site Nu
site 00, which represents the contract as a whole, in addition to any other sites.   

Site Proposal sites represent work locations for which time charges are accrued.  The def
situation is for a single site of time charges to accrue on the contract as a whole.  If contractors 
will construct several project entities (for example, bridges
treat each project entity as a separate site to assign completion time and assess liquidated 
damages.   

Social Security Number The social security number of the vendor officer.   

Source of Price A value, selected from the attach
originating source of an estimated price for an item (e.g., estimated or h
“E” for estimated.  You can indicate in the Source of Price field how Trns•port determined
estimated or revised price.  Trns•port sets it to E, but you can change it.  This field identifies 
where the estimated price came from, but does no
price field can contain an “E” for the engineer estimated the cost, “GBBA” for a bid-based 
average, “GBBR” for a bid-based regression, or “H” for a historical price. 
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Spec Bk Year is available to indicate in Trns•port the year of the specification book that
govern the administration of the par

 is to 
ticular contract.  The default value is 04. 

designed at 
ch item (such as 

projects already in progress.  
y.  You can distinguish 

ld identifies the specification year item list used on the 

scription of the special provision.  Not in use by 

n use by the Department. 

y 
ment. 

sal 

 special start date will be 

e 

eaning of projects already in progress.  Instead, you can create entirely 
is field.   

r 

Spec Book The general rules covering acceptable work and practices for contracts with an 
SHA.   

Spec Year A default value of 00 has been set.  Because Trns•port contains projects 
different times, you cannot change the reference information about ea
description and unit).  Doing so would change the meaning of 
Instead, you can create entirely new reference item lists when necessar
these lists by a specification year.  This fie
project.  You are not required to, but you can enter information in these fields to record 
additional information about a proposal. 

Special Provision Code A unique identifier for a special provision.  Not in use by the 
Department. 

Special Provision Description A short de
the Department. 

Special Provision Text File Name A field that identifies the library member of which the 
special provision is a part.  Not i

Special Provision Type A coded value indicating the type of special provision.  Not in use b
the Depart

Special Provisions This feature is not now in use by the Department.  Flag used to tell 
Trns•port if you will assign special provisions to this proposal that are print with the propo
schedule.  The default value is N (you have assigned no special provisions). 

Special Start Date Available to indicate to bidders cases where a
established. 

Specialty Item Flag Indicates whether an item is a specialty item.   

Specification Number A classification number for types of construction items as used in th
Specification Book.   

Specification Year Because Trns•port contains projects designed at different times, you 
cannot change the reference information about each item (such as description and unit).  Doing 
so would change the m
new reference item lists when necessary.  See Pay Item Year for FDOT use of th

Specified Completion Date The projected date when the contractor will complete work for a 
given site.  Maintenance Contracts should indicate the contract completion date in this field, fo
example June 30, 2005. 

Specified Start Date The project date when the contractor will start work on a given site.  
Maintenance Contracts should indicate the contract start date in this field, for example July 1, 
2004. 
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State Mat Flag (State Furnished) The default value for this field is "N".  You may have a 
few non-biddable items that by all logic seem to belong grouped together with the biddable 

ws 
s 

 appear in any bid documents, and will not be passed to SiteManager.  A common use 

s 

tus of a 
 let) or left blank.  Trns•port includes this field on 

 The date you entered the status.   

ore than one file, so 

s and funds (the whole tree of data).  (See also Delete and Power Delete)  

SUPP Code 

ontract in Trns•port describes the contract work that the prime contractor 
es.  

 the 

Supplemental Agreement A written agreement between the contracting authority and the 
contractor that you execute on the prescribed form and get approved as required by law.  The 

items.  You could create an artificial, non-biddable project for those items, but Trns*port allo
you to enter them in the logical place, and flag them by placing a `Y' in this field.  Non-Bid item
will not
for this field is to identify FHP use on a project. 

State of Incorporation A coded value indicating the state in which the vendor company i
incorporated.   

State, Zip The two-letter state code and zip code for the district’s address.   

Status A value (which must appear in the PRJSTAT code table) used to indicate the sta
project (for example, in design or ready to
some reports, but does not use it elsewhere.   

Status Date

Status of Bid A coded value indicating the status of the vendor's bid.   

Status of Letting A coded value indicating the status of the letting (for example, planned, 
scheduled, or postponed).   

Stockpile A quantified amount of a material delivered to the contract site for use in a specific 
item.   

Stockpile Change Adding new material to a stockpile or removing material already in the 
stockpile for placement in a regular/structure/sewer item.   

Strong Delete The third level of deleting.  Deletes multiple records from m
you should see three Delete Warning windows.  For example, if you are deleting a bid-letting 
package, Strong Delete will delete the letting call, bids, planholders, the proposal and the 
projects, item

Structure Work Type Similar to the Federal Work Category, except that the FED
Table is used.   

Subcontract A subc
will not perform.  You may divide subcontracts into items and define subcontracted quantiti
Each subcontract item can have a partial item percentage applied to it, which indicates that the 
subcontractor will perform only part of the item work.   

Subcontractor An individual, firm or corporation to which the contractor sublets part of
contract.   

Subcontractor An individual, firm, or corporation to which the contractor sublets part of the 
contract.   

Subcontractor Payment Money paid by the contractor who holds a contract with the 
Department to a vendor that might be the subject of a DBE commitment for the contract.   
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supplemental agreement covers extra work, alterations, or adjustments as provided for within th
scope of the contract.  The extra work or change order constitutes a modification of the contr
as originally executed and approved.   

Supplemental Description 2 An additional 40 characters used for item descriptions.   

Supplemental Description Used only for mis

e 
act 

cellaneous items.  Not in use by the Department 

l Item year Can be used by the agency to denote a supplemental item year in 

n renamed to Specification Book Year and is 

port uses 
ork performed in a 

tes that a vendor might be a supplier of materials only.   

e vendor code of the surety agent for this bid.  The value entered here must appear in the 

 vendors for storing information in 

e.   

AASHTO's information system for managing transportation programs.  A 
 

ES, Trns•port PES, Trns•port LAS, Trns•port CAS, and Trns•port BAMS/DSS.   

um 

at this time. 

Supplementa
addition to the primary item year.  Trns•port does not use this field in any processing  

Supplemental Proposal Description Additional project-specific descriptive information for 
a project item.   

Supplemental Specification Year has bee
available for projects and proposals as necessary.  

Supplementary Work Code Similar to the Federal Work Category except that Trns•
the FEDSUPP code table.  A coded value indicating the type of federal w
category.   

Supplier Only Flag Indica

Surety Agent ID Trns•port treats surety agents as vendors for information storage.  This field 
holds th
VENDOR file.   

Surety Company ID Trns•port treats surety companies as
Trns•port.  This field holds the vendor code of the surety company for this bid.  The value 
entered here must appear in the VENDOR file.   

Text Box A dialog box component that accepts input you type in or copy from another fil

Time Charge Number of days worked on a particular site.  Used to track contractor work time 
and assess liquidated damages, if necessary.   

Time Extension A modification (usually an increase) in the time a contractor can work on a 
contract without incurring a penalty.   

Time Method See Type of Days.   

Time of Letting The time a letting will be held.   

Title of Officer The title of a vendor officer.   

Trns•port 
computerized system through which a SHA can manage construction projects.  Modules include
Trns•port C

Type of Action The type of action (add, change or delete) to be performed by an addend
item.   

Type of Bid Received A coded value indicating the type of bid.   
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Type of Corporation A coded value indicating the type of business structure used by a 
vendor.   

Type of Days A coded value indicating whether Trns•port should base contract time on 
 

 (Materials) A coded value (which must appear in the ITEMTYP code table) 

posal (P) 

 the FM system.  If it is in error, see the Work Program 

e of vendor.   

ork Classification A coded value (which must appear in the VWRKCLS code 

f Line is L at the item level.  Trns•port uses this field in production and 

 a 

rts in the Detailed Estimate.  If you do not assign a 

e.  The default value is 

ar in the UNITS code table) indicating the 
 for lump sum items.   

ed with the adjustment index.   

 that indicates whether the 
project classification is rural or urban. 

available working days, calendar days, or a completion date.  Maintenance contracts should
indicate Completion Date in this field. 

Type of Item
identifying the material type of the item.   

Type of Line Indicates whether the proposal line is at the item (L), section (S), or pro
level.   

Type of Road This field is entered from
office to have it corrected. 

Type of Vendor A coded value indicating the typ

Type of Vendor Certification A coded value indicating the type of work a vendor is 
authorized to perform.   

Type of W
table) indicating the classification of work the vendor is qualified to perform.   

Uncompleted Work The amount of work, in dollars, a vendor has outstanding.   

Unit Bid Price The bidder's unit price for a line item in the proposal.  Trns•port requires this 
field if the Type o
Trns•port BAMS/DSS models use it.   

Unit Description The description to appear on the unit-level funding summary report for
given unit number.   

Unit Number A unique identifier for a unit.  You may put whatever values you like in this 
field.  Unit numbers provide a way to group categories for reporting purposes on the Funding 
Summary and Funding Summary by Unit repo
unit number, the unit number will appear as 000 on the Funding Summary report.  When you 
assign a unit number and project-level funding, be sure to assign a unit number to all categories, 
not just the 0000 category (project-level funds).  Not in use at this tim
000.  Do not change this value. 

Unit of Measure A coded value (which must appe
type of measurement used to determine one unit

Unit See Unit of Measure.   

Unit System This field indicates whether a project will contain items designated as English 
(E), metric (M), or neither (N).   

Units for Lump Sum Items A coded value indicating the type of measure for the item 
associat

Urban/Rural Class A value selected from the URBRUR code table
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User Name The name by which Trns•port knows you.   

User Permission A user's right to view and edit the information in a project file.  Each file can 

the 

sal.   

 

e vendor name (short description).   

er The vendor's phone number.   

 can also use 
t 

s, and 
es.   

 A user's right to look at the information in a project file.  Each file has one 
s a 

ile 

 

 cover unusual circumstances.  Trns•port maintains a complete 

tage amount indicating the goal that has been set for women 

e prime contractor has actually paid to date to WBE 

ise.   

 
rator.   

have one or more people listed as users for that file.  User permission differs from owner 
permission in that someone with user permission cannot view or edit the project user list for 
file.   

Valid for Bidding Flag Indicates whether a planholder purchased a valid-for-bidding propo

Vendor Address The vendor's address.  

Vendor City The vendor's city.   

Vendor Name (Long) The vendor name (long description).   

Vendor Name (Short) Th

Vendor Number A unique identifier for a vendor.   

Vendor Officer The name of an officer for a vendor.   

Vendor Phone Numb

Vendor State The vendor's state address.   

Vendor Trns•port uses the Vendor file to maintain information about contractors, 
subcontractors, suppliers, surety companies, surety agents, and escrow agents.  You
it to store information about counties (or other municipalities) and utilities that perform relevan
work.  Trns•port uses information about these vendors, their affiliations, officers, addresse
facilities in numerous Trns•port process

Vendor ZIP Code The vendor's zip code.   

Viewer Permission
or more people listed as viewers for that file.  Trns•port automatically allows whoever create
file to look at the file because Trns•port gives that person owner permission.  The owner of a f
can also give other users viewer permission for that file.   

Voucher A Trns•port voucher describes a contractor progress payment for a specific project. 
Trns•port computes voucher information automatically and accounts for partial item quantities 
performed, material allowances, retainage and liquidated damages.  You can make other 
payment adjustments manually to
audit trail of all voucher related information, which allows Trns•port to regenerate previously 
paid vouchers for review.   

WBE Goal (PCT) A percen
business enterprises for the proposal. 

WBE Goal The dollar amount th
subcontractors and suppliers.   

WBE Woman Owned Business Enterpr

Wild Card A character that can substitute for other characters.  You can use a * or ? in the Filter
window's Value field with the Like ope
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Work Mix This field is entered from the FM system.  If it is in error, see the Work Program 

form.    

office to have it corrected. 

Work Type Code A coded value indicating the type of work a vendor is qualified to per
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Appendix B Control Group 

The assignment of Access Control Groups is one of the principal tools available to the 
Department to control access to project data.  Through the plan outlined here, a hierarchy can be 
established where data may be compartmentalized to restrict access to a set of people who need 
visibility of a particular project and to deny visibility to those who don’t. 

The use of Control Groups satisfies two concerns.  The first is to reduce the volume of 
information that will appear on Project List screens, and second to secure information during the 
bidding and award process.  The use of Control Groups allows the visibility projects to be moved 
from one person to another.  An example would be a project in District 2 that might have a 
Control Group of CD02PMA.  With this Control Group assigned to the project, the District 
Estimator(s), having a personal Access Control Group of CD02*, would always have visibility of 
the project.  Similarly, any person having an Access Control Group that is less restrictive would 
also be able to see the project on his or her project list screen.  For example, a user with an 
Access Control Group of C* would have access to every project in the Production organization 
statewide. 

For the management of projects for Central Office letting, the sequence of Control Groups 
assigned to the Project, and the Proposal header when it is created, would be as follows: 

• CD02PMA: When under the control of a District Project Manager. 

• CD02: When control of the project shifts from the Project Manager to the District Estimator. 

• CC02: When the District Estimator transfers the proposal to the Central Office for letting.  A 
further refinement here will be decisions in the Central Office Estimates Office about 
compartmentalizing within itself.  For example, a particular estimator may use CC02TW 
(initials) to assign the access to another estimator, or CC02A to have proposals shared by two 
or more Estimators as a group within the overall estimates office. 

• CT02: When the proposal is ready for processing by the Central Contracts Administration 
Office.  It is necessary that the proposal Control Group remain unchanged while the project is 
in LAS and the Contracts Administration Office in order to ensure that the Engineer’s 
estimate is always under the control of only the estimator. 

The following table illustrates how visibility of projects to a community (Maintenance or 
Production) for oversight is granted, and then to a smaller group of project or maintenance staff 
for the control and management of project detail. 



Reference Manual for Production Projects & Proposals PES Release 5.7a                                         Page 119 of 129 

         PES  LAS 

* 

istrict Estimator      CD##A* CD##A* 

##A* None 

 

Dis

Cen   None 

Cen

Cen CT*  CT* 

Character position 1:  M = Maintenance Project 

C = Construction Project 

Other characters may be assigned if desired to segment project development to other specialty 
areas. 

District Contracts Manager      ?L##*  ?L##

District Contracts Assistant A      ?L##A* ?L##A* 

District Contracts Assistant B      ?L##B* ?L##B* 

 

District Production Director      CD##PM* None 

District Production Project Manager A    CD##PMA* None 

District Production Project Manager B    CD##PMB* None 

District Project designed by Consultant Firm    CD##T### None 

 

District Estimator       CD##*  CD##* 

Assistant D

 

District Maintenance Engineer     MD##* None 

Assistant District Maintenance Engineer A    MD

District Maintenance Contract Estimator    MD##* MD##* 

Assistant District Maintenance Contract Estimator   MD##A* MD##A* 

trict Work Program Manager     ?D##*  None 

tral Maintenance Manager     M*

Central Estimator       CC*  CC* 

tral Office Production Manager     CC*  None 

tral Office Contracts Manager     

 

Control Group Structure: 
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Character position 2:  D = District Office processing 

C = Central Office processing 

T = Central Contracts Administration Office 

L = District Contracts Administration Office 

 

Character positions 3 & 4: District Number 

Character position 5: The letters T, U, V, W, X, Y, and Z are reserved for Central Office and 
statewide use.  When a consultant firm is the designer of a project, the last four characters of the
control group will identify the consultant firm.  The letters T, U, V, W, X, and Y identify 

 

 project created in the Central Office could be assigned an office code. 

in character position 5, identify the firm. 

 

Application Managers and Security Coordinators. 

 

is 
 

it. 

e 

olve in the following manner: 

consultant firms. 

A

Character positions 6/7/8: Organizational or subordinate breakout where desired.  For 
consultant firms, these three characters, in conjunction with a letter 

For those projects let through the DCP system today, Central Office staff would rarely require 
access to them for control or change purposes, but may have visibility of them depending on the
Control Group structure finally developed. 

The Control Group feature is a very important tool, but it has limitations: 

• It is not a code table and, therefore, will require a thorough understanding of the structure by 

• Control Group is not available to Letting Headers. 

• When transferring a project or proposal to another user, care must be taken to ensure that all
letters in the new Control Group are capitalized, and that a valid Control Group has been 
used.  If these precautions are not taken, a project or proposal will be removed from the 
project or proposal list screen of the previous user and will be available to no one.  Under th
circumstance, a user with high-level authority such as a Security Coordinator or Application
Manager will have to find the errant project or proposal and assign a valid Control Group to 

Control Group Life Cycl

A Control Group assigned to a project/proposal might ev
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Maintenance Contract 

 Receive Maintenance Project from FM MD## 

MD##A (or other subset) 

MD##A 

Pass to Contracts office   ML## 

 ML## (or subset if desired) 

award and execute phases  ML## 

 District reassigns proj

   Or 

 CD## 

 ## (or subset if desired) 

## 

 

 

 

 Create Proposal Header & Price Job  CD## 

ator   CC## 

 Pass to Central Estimator for Bid Analysis CC## 

 Return record to Contracts office  CT## 

 Complete award and execute phases  CT## 

 

 District reassigns project internally  

 Create Proposal Header   

 

 Contracts Administration Office activity

 Pass to "estimator" for Bid Analysis  MD## (or other person) 

 Return record to Contracts office  ML## 

 Complete 

Construction Project 

 Receive Production Project from FM  CD## 

ect internally  CD##A (or other subset) 

 District reassigns to consultant firm  CD##T365 (or other subset) 

 Pass file to District Estimator  

 Create Proposal Header   CD## 

 Pass to District Contracts office  CL## 

Contracts Administration Office activity CL

 Pass to Distr Estimator for Bid Analysis CD

 Return record to Contracts office  CL## 

Complete award and execute phases  CL## 

  Or for Class 1 Contract 

Pass file to District Estimator   CD## 

 Pass to Central Estim

 Pass to Central Contracts Admin. Office CT## (or subset if desired) 
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Appendix C Filtering and Sorting 

The Trns•port Filter 

A  provides the user with a means to limit t st of records appearing in a filter he li  window.  The 
cially helpful in limiting an 

em Li  selec on criteria on one or more fields applicable to the active 

d lower case characters.  Fields that are 
ll be in ainframe stores 

veryth  It  Description is in uppercase, so when filtering on 
e Sho ase characters.  All code values are stored in 

 search for uppercase letters.  Other fields, such 
he Location field on the Project Header record, can have both upper and 

erform

• 

• 

he list s  available for the search.  The 
s th t are a e between the field that chosen in the 

n The Value contains a literal that is being 
ompar

Click the Column, Operator, and Value fields to display lists of values from which to choose the 
information to be filtered. 

Filter Function is available on most LAS and PES screens.  It is espe
it st.  Use the filter to enter ti
window.   

PES and LAS are set up to support both upper an
populated from the Department mainframe wi  uppercase because the m
e ing in uppercase.  For instance, the em
th rt Description field, look for all upperc
uppercase.  When filtering on a code-based field,
as the second line of t
lower case letters in them.  Be 
aware of the case of a field when 
p ing a filter. 

To use the Trns•port filter: 

Click the icon that looks 
like a funnel.  

 

 

 

 

 

 

 

 

This screen will appear.   

 

 

T  box labeled Column will list all of the field  that are
Operator list box contains the relationship a vailabl
Colum  list box and the entry in the Value box.  
c ed to the field in the Column box.   

 



Column  he Column field contains the nT ames of the most commonly used columns 
in the table from which the list window is built.  When you click the down 

row in the column field, the list of columns to choose from will appear.  

to (<>), and Contains and Does Not (contain) to narrow the filter.  Select 

 

he operator 
 set fo

tenance 

The resulting Projects List 
win w

indow, click the Filter button 
gain, and then click Show All.  
his will restore the complete 

ifferent criteria in the operator 
eld or a different value. 

The d

ou may also filter information using a 
plex set of criteria.  Click the 

dvanced button and Trns•port displays 

ombinations. 

ar
Select the column you desire. 

Operator  The Operator field contains the operators equal to (=), greater than (>), less 
than (<), greater than or equal to (>=), less than or equal to (<=), not equal 

the operator you desire. 

Value The information you type in the Value field is the filter criterion to match.

 

This illustrates a filter on the Projects List 
window, set to select on the Federal/State 
Project Number column, with t
selected as =, and the Value
This value will select Main

r N/A.  

projects in this example. 
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do  appears. 

If the selection results in a blank 
w
a
T
window list, and try again with 
d
fi

 

 

 

 A vanced Filter 

Y
more com
A
the Advanced Filter window.  This 
window allows you to use multiple 
combinations of conditions to filter with 
various operators, values, and logical 
c

Use the Advanced Filter window to build a 
set of conditions for Trns•port to use to 



filter information.  This set of conditions consists of a series of “where conditions” combined 
 such as And/Or, (+ and (–.  Create each where condition by choosing a 

olumn, Operator, and Value fields and then clicking the ACCEPT button. 

olumn field contains the names of 

with logical options,
value in each of the C

Column The C all the columns in the table from which 
the lis
list of

Operator The O nd 
Not Like, operators used for pattern matching. 

The i
a delimiter or are trying to match. 

r
alue that contains the characters "*" or "?", use the 
 "?".  For example, Quantity \* item would search for 

acter, put a backslash in front of the "\"; for example, 

t window is built.  When you click the down arrow in the column field, the 
 columns to choose from will appear. 

perator field contains all the operators found in the basic filter plus Like a

Value  nformation you type in the Value field is the filter criterion you are using as 

Use "*" as a wild card to match any value o
or NOT LIKE operators.  To search for a v
backslash character (\) just before the "*" or
Quantity * item.  To search for the "\" char
use \\job

 "?" to match a single character only with the LIKE 

 to search for \job. 

Trns•port displays each where condition in the Select Where area of the Advanced Filter window 
eate

 them into a “where clause” by clicking in the And/Or column to the right of 
cting the appropriate option from the menu for each line.  Typically, 

 combined before the lines requiring And. Use the logical options 
r combinations where necessary. 

r the Column, Operator, and Value fields at the top of the 

Click the Accept button.   

o add another row,  

• Click the Add Row button,  

• Click the row just added.   

alues in the 

se 

in the order in which you cr
are listed, combine

 them.  After all of the where conditions you need for the filter 

each condition line and sele
all lines requiring Or should be
(+ and (– to override the And/O

To add the first row: 

• Click or enter values fo
screen. 

• 

T

• Click or enter v
Column, Operator, and Values 
fields. 

• Click the Accept button. 

Add parenthesis as needed and choo
either And or Or as appropriate.   
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To save a filter: 

• Enter a name in the Name field. 

• Click the Save button.  

The filter will be available for future use.   

 

ple is Bid Letting 
on

filter is named 

lick th
save th

Name field. 

lects on 
in District 3, follow 

these st

tion by 
 

• 
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This exam
Number; C tains; CT?.  This 

CT Lettings.   

• C e SAVE button to 
e filter.   

• Click APPLY 

The results of this advanced 
filter appear.   

 

Reuse a filter. 

This and other advanced filters 
may be re-used by:  

• Click the Filter Icon. 

• Click the ADVANCED button. 

• Click the down arrow in the 

• Click the name of the filter. 

• Click APPLY.   

To build a filter that se
Maintenance Projects 

eps: 

• Create the first where condi
selecting values in each field

Click the ACCEPT button.   



The information will be moved to the 
low s
select And/Or

 

• Highlight the new row.   

 

 

ond where condition 

e ACCEPT button. 

ame the filter you have built.  In this 
me given is D3 

lter is 
AVE button to save 

this t e it in the 
future. 

 

Click the A
the u
filt ist 

pen the advanced 
filter, click the name window to 
sele a
adjust c
may e
You may always restore a full 
list by clicking on Show All at 
the regular filter. 

To use the filter again, select the 
filter name from the list box.  

To remove the saved filter from the database, Click DELETE.  

er ection as row one, and you may 
.  In this case select And. 

• Click the ADD ROW button. 

This makes the Build Where Con
window active for the new row. 

dition 

• Create the sec
as shown here. 

• Click th
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N
example, the na
Maintenance.  The name can be up to 30 
characters long.  Now that the fi
complete, click the S

 fil er so that you may reus

PPLY button to see 
 res lts of this two-condition 
er on the Projects L

window, where it was built.   

If the filter doesn’t work the 
first time, reo

ct nd reopen the filter, and 
ondition statements that 

 b  causing the problem.  



Sorting Information 

To sort information in a list window, clic
Sort button.  It is located to the right of th

k t
e Filter 

utton.  Trns•port displays the Sort window. 

The o of all 
column  to build the list 
window.  When you click the down arrow in the 

se from will appear. 

cending (A-Z) or descending (Z-A) sort order for the selected 
olumn.  When values containing both numbers and letters are listed in ascending order, numbers 
recede letters, and vice-versa for descending order. 

In t  

• l/State Project Num

s to the 
list window. 

seen here. 

ote that as in the Advanced 

g 
t 

ct

, Trns•port displays a help window with information about sorting a list 

hat it must be set up each time you wish to use it.  There is no 
g or saving feature associated with it. 

he 

b

 C lumn field contains the names 
s in the table that are used

column field, the list of columns to choo

Click Asc or Desc to select an as
c
p

his example,  

Click the Federa ber. 

• Click APPLY.  

If you Click CANCEL, Trns•port return
list window without sorting the 

 

Trns•port sorts the rows in the 
order you specified.  The results 
may be 

N
Filter functions, the Sort 
functions may also be made 
complex.  You may sort on 
different fields and establishin
a sort order.  You may add sor
criteria by clicking the ADD 
button to add a row, and so 
forth. 

If you Click INSERT, Trns•port 
inserts another row for sort 
criteria before the currently sele
selected row of sort criteria. 

If you Click HELP

ed row.  If you Click DELETE, Trns•port deletes the currently 

window. 

One difference with Sort is t
namin
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Appendix D Printing and Savi

Access the task bar 

 that it near

When you Click the ICA Icon, you will see the 
ICA connection center as seen at the left 

A Client File Security window will open. 

LL ACCESS  
k NEVER ASK ME AGAIN FOR 

u 

 

ng with Citrix Metaframe 

Use of the Citrix Metaframe 
server, requires certain setup for 
you to save the reports to the PC 
and for printing them to the 
network printer. 

To set up access to the PC, 
Login to any Trns•port 
application.  
on the PC.  As seen at the right.  

• Click the "ICA 
Connections" 
Icon.   

 

You will see  the clock. 

 

• Click the Security button. 
 

 

 

 

 

 

 

The IC

• In the upper box Click FU

• In the lower box Clic
ANY APPLICATION. 

• Click OK. 
With this choice you may access the A drive or the C drive for any Trns•port application yo
work in. 

• Click OK on the ICA Connections window to complete the setup and close the ICA
connection center. 
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You are now ready to save a 
report from Trns•port.   

en 

er the Save As 

 
 
 
 
 

n
 

blclick Documents and Settings. 
 
 
 

• Dblclick the Userid or Name, depending on how 
your PC is set up. 

 
 

Dblclick My Docum

 

 

n you reach the folder you seek, 

In the process list window op
a report and it will appear 
similar to the one seen here. 

• Click eith
Text, or Save As Rich 
Text button. 

 
 

 'Client"(V:)"  • Dblclick "C$ o

 
 
 

• D

 
• ents. 

 

You should now recognize the directory structure on your 
PC.  Whe

• Click the OPEN button to save the file. 
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